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BAB 1 

KONSEP DASAR SISTEM INFORMASI GEOGRAFIS 

 

1.1. Tujuan 

a. Memahami Definisi Sistem Informasi Geografis. 

b. Memahami Komponen Utama Sistem Informasi Geografis. 

c. Memahami Tahapan dalam Sistem Informasi Geografis. 

d. Memahami Data Sistem Informasi Geografis. 

e. Mengetahui kegunaan Software yang digunakan. 

 

1.2. Definisi Sistem Informasi Geografis 

Sistem Informasi Geografis (SIG) merupakan sistem 

informasi berbasis komputer yang digunakan untuk mengolah dan 

menyimpan data atau informasi geografis (Arnoff, dalam Denih et 

al (2020). Secara umum pengertian SIG yaitu suatu komponen yang 

terdiri dari perangkat keras, perangkat lunak, data geografis dan 

sumber daya manusia yang bekerja bersama secara efektif untuk 

memasukan, menyimpan, memperbaiki, memperbaharui, 

mengelola, memanipulasi, mengintegrasikan, menganalisa dan 

menampilkan data dalam suatu informasi berbasis geografis. Sistem 

Informasi Geografis ini dapat menganalisis data spasial dari berbagai 

macam cara dan menghasilkan presentasinya dalam bentuk peta atau 

yang lainnya. 

1.3. Komponen Utama Sistem Informasi Geografis 

Komponen utama sistem informasi geografis sebagai berikut: 
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1. Hardware 

Hardware terdiri dari komputer, GPS, Printer, Plotter, dan 

lain-lain. Dimana perangkat  keras ini berfungsi sebagai media 

dalam pengolahan/pengerjaan SIG. Mulai dari tahap 

pengambilan data hingga ke produk akhir baik itu peta cetak, 

CD, dan lain-lain. 

2. Software 

Software merupakan sekumpulan program applikasi yang 

dapat memudahkan kita dalam melakukan berbagai macam 

pengolahan data, penyimpanan, editing, hingga layout, ataupun 

analisis keruangan. 

3. Data 

Data dalam sistem informasi geografis dibagi atas dua 

bentuk, yakni Data Spasial (geographical) dan data non spasial 

(data atribut). 

4. Metode 

SIG didesain dan dikembangkan untuk manajemen data 

yang akan mendukung proses pengambilan keputusan 

organisasi. Pada beberapa organisasi penggunaan SIG dapat 

dalam bentuk dan standar tersendiri untuk metode analisisnya. 

Jadi, metodologi yang digunakan merupakan salah satu faktor 

penentu keberhasilan untuk beberapa proyek SIG. 
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5. Manusia 

Manusia menjadi salah satu element yang berfungsi 

memberikan peranan operasi dalam komponen SIG, manusia 

disini dalam arti orang yang mengoperasikan atau menggunakan 

peranti SIG. 

 

1.4. Tahapan Sistem Informasi Geografis 

Secara garis besar, sistem informasi geografis terdiri dari empat 

tahapan yaitu sebagai berikut: 

1. Tahap Input Data 

Pada tahapan yang paling awal ini dilakukan proses 

memasukan data-data spasial dan informasi spasial yang 

memiliki keterangan terhadap posisi geografis, ukuran dimensi, 

karakteristik dari suatu objek. Tahap input data ini juga meliputi 

proses perencanaan, penentuan tujuan, pengumpulan data, serta 

memasukkannya kedalam komputer. 

2. Tahap Pengolahan data 

Pada Tahap ini meliputi kegiatan klasifikasi dan stratifikasi 

data, komplisi, serta geoprosesing (clip, merge, dissolve). 

Proses ini akan menghabiskan waktu dan biaya mencapai 20% 

dari total kegiatan SIG. 

3. Tahap Manipulasi dan Analisis Data 

Pada tahap manipulasi dan analisis data ini menentukan 

informasi yang mampu dihasilkan oleh SIG, sehingga 

selanjutnya untuk memisahkan dengan data yang akan diterima 

SIG. Contoh pada tahap manipulasi dan analisis data diantara 
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lain yakni: 

a. Scoring: Yaitu sebuah tahapan pemberian nilai dan 

sifat parameter yang dipakai pada saat menganalisis. 

b. Overlay: Proses penggabungan dua data bahkan lebih 

agar bisa menghasilkan data grafis dengan begitu akan 

tercipta satuan pemetaan baru. 

c.  Buffering: Tahap pembuatan polygon baru sesuai 

dengan jarak pada umumnya. Tahapan ini selalu 

diterapkan pada jenis data garis, titik, poligon dan area. 

4. Tahap Output Data 

Tahap ini merupakan fase akhir, dimana ini akan berkaitan 

dengan penyajian hasil analisa yang telah dilakukan. Data yang 

telah diolah melalui proses dalam analisis SIG akan 

menghasilkan informasi spasial baru. 

 

1.5. Data Sistem Informasi Geografis 

Pada prinsipnya data sistem informasi terdiri dari dua jenis data 

yaitu: 

1. Data Spasial 

Data spasial adalah data yang merepresentasikan atau 

mengidentifikasi letak geografis (posisi ruang) dari suatu fenomena. 

Contohnya seperti letak pegunungan, garis bujur dan lintang, hutan, 

kepulauan, letak suatu daratan, sumber minyak bumi serta lainnya. 
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Gambar 1. Data Spasial 

Dalam sistem informasi geografis sendiri, data spasial dapat 

direpresentasikan dalam dua format yaitu sebagai berikut: 

a. Format Data Vektor 

Data vektor merupakan suatu bentuk bumi dimana 

bentuk tersebut direpresentasikan dalam suatu bentuk 

kumpulan dari garis, area (dimana di suatu daerah dibatasi 

dengan menggunakan garis yang berawal dan yang berakhir 

di sebuah titik yang mirip), nodes dan titik. 

Data vektor digunakan untuk menganalisa sesuatu yang 

membutuhkan ketepatan dari suatu posisi, contohnya pada 

suatu basis data yang batas-batasnya kadaster. Contoh 

penggunaan data tersebut yaitu digunakan untuk menafsirkan 

suatu hubungan spasial dari berbagai fitur. Kelemahan dari 

data vektor yang paling utama yaitu data tersebut tidak bisa 

mengakomodasikan terhadap perubahan gradual. 
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Gambar 2. Format Data Vektor 

(Sumber: vimeocdn dalam citrasatelit.com) 

 

b. Format Data Raster 

Data raster sering disebut juga dengan sel grid, dimana 

objek geografis direpresentasikan sebagai struktur sel grid 

yang disebut pixel. Sehingga resolusi tergantung pada ukuran 

pixelnya. Dengan kata lain, resolusi pixel menggambarkan 

ukuran yang sebenarnya dipermukaan bumi yang diwakili 

oleh setiap pixel pada citra. 

Semakin kecil setiap ukuran dari permukaan bumi yang 

direpresentasikan oleh suatu sel, maka semakin tinggi juga 

resolusinya. Data tersebut juga sangat baik ketika digunakan 

untuk direpresentasikan pada batas yang bisa berganti 

dengan secara gradual, contohnya yaitu: kelembaban tanah, 

suhu tanah dll. 



7 
 

 

Gambar 3. Format Data Raster 

(Sumber: vimeocdn dalam citrasatelit.com) 

Salah satu syarat SIG adalah data spasial, yang dapat 

diperoleh dari beberapa sumber antara lain: 

1) Peta Analog 

Peta analog (antara lain peta topografi, peta tanah dan 

sebagainya) yaitu peta dalam bentuk cetak. Pada umumnya 

peta analog dibuat dengan teknik kartografi, kemungkinan 

besar memiliki referensi spasial seperti koordinat, skala, arah 

mata angin dan sebagainya. Dalam tahapan SIG sebagai 

keperluan sumber data, peta analog dikonversi menjadi peta 

digital dengan cara format raster diubah menjadi format 

vektor melalui proses digitasi sehingga dapat menunjukan 

koordinat sebenarnya di permukaan bumi. 

2) Data Sistem Penginderaan Jauh 

Data Penginderaan Jauh (antara lain citra satelit, foto 

udara dan sebagainya), merupakan sumber data yang 

terpenting bagi SIG karena ketersediaanya secara berkala 
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dan mencakup area tertentu. Dengan adanya bermacam-

macam satelit di ruang angkasa dengan spesifikasinya 

masing-masing, kita bisa memperoleh berbagai jenis citra 

satelit untuk beragam tujuan pemakaian. Data ini biasanya 

direpresentasikan dalam format raster. 

3) Data GPS (Global Positioning System) 

Teknologi GPS memberikan terobosan penting dalam 

menyediakan data SIG. Keakuratan pengukuran GPS 

semakin tinggi dengan berkembangnya teknologi satelit 

navigasi. Pengolahan data yang bersumber dari GPS 

biasanya dilakukan dalam format vektor. 

4) Data Hasil Pengukuran Lapangan 

Data pengukuran lapangan yang dihasilkan berdasarkan 

teknik perhitungan tersendiri, pada umumnya data ini 

merupakan sumber data atribut contohnya: batas 

administrasi, batas kepemilikan lahan, batas persil, batas hak 

pengusahaan hutan dan lain-lain. 

2. Data Non Spasial (Atribut) 

Data non spasial merupakan data yang menjabarkan aspek dari 

suatu fenomena dalam bentuk deskripsi atau penjelasan yang 

terperinci. Data ini tergambar dalam bentuk kata- kata, angka, serta 

tabel. Data Atribut dapat menyimpan semua jenis informasi statistik 

deskriptif yang berbeda, yang dapat dibagi menjadi empat kategori 

berbeda: nominal, ordinal, interval, dan rasio. Data atribut nominal 

memberikan informasi deskriptif tentang objek seperti warna objek, 

nama objek, misalnya nama kota, atau jenis objek. Yang penting di 
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sini adalah bahwa informasi deskriptif ini tidak menyiratkan urutan, 

ukuran, atau informasi kuantitatif lainnya. Data atribut yang dapat 

dijumpai pada data kepadatan penduduk, data luas wilayah, jenis-

jenis tanah, data demografis, dan sebagainya. 

 
Gambar 4. Contoh Data Non Spasial 
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1.6. Software yang digunakan 

Software yang akan digunakan: 

1. ArcGIS 

 

Gambar 5. ArcGIS 

ArcGIS adalah salah satu software yang dikembangkan oleh 

ESRI berupa perangkat lunak yang menyediakan kerangka kerja 

yang bersifat scalable (bisa diperluas sesuai kebutuhan) untuk 

mengimplementasikan suatu rancangan aplikasi SIG baik bagi 

pengguna tunggal (single user) maupun bagi lebih dari satu 

pengguna yang berbasiskan desktop, menggunakan server, 

memanfaatkan layanan web, atau bahkan yang bersifat mobile untuk 

memenuhi kebutuhan pengukuran di lapangan. 
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2. Arduino IDE (Integrated Development Environment) 

 

Gambar 6. Arduino IDE 

Arduino IDE adalah software yang disediakan di situs arduino.cc 

yang ditujukan sebagai perangkat pengembangan sketch yang 

digunakan sebagai program di papan Arduino. IDE (Integrated 

Development Environment) berarti bentuk alat pengembangan 

program yang terintegrasi sehingga berbagai keperluan disediakan 

dan dinyatakan dalam bentuk antarmuka berbasis menu. 

 

3. Firebase 

 

Gambar 7. Firebase Realtime Database 

Firebase Realtime Database merupakan Database realtime yang 

tersimpan di cloud dan support multiplatform seperti Android, iOS 

dan Web. Data pada firebase akan disimpan dalam struktur JSON 

(Java Script Object Notation). Database firebase akan melakukan 

sinkronisasi secara otomatis terhadap aplikasi client yang terhubung 

kepadanya. Aplikasi multiplatform yang menggunakan SDK 
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Android, iOS dan JavaScript akan menerima update data terbaru 

secara otomatis pada saat aplikasi terhubung ke server firebase. 

 

4. Avenza Maps 

 

Gambar 8. Avenza Maps 

Avenza Maps merupakan suatu aplikasi yang memperlihatkan 

atau menampilkan struktur dari sebuah data lokasi bangunan. 

Koordinat bangunan mendeskripsikan jenis-jenis objek dalam 

sistem dan berbagai hubungan statis yang terdapat di tempat survei. 

Avenza maps pada studi kasus ini akan digunakan untuk 

mengumpulkan data koordinat lokasi secara langsung/survei. 

 

5. XAMPP 

 

Gambar 9. XAMPP Localhost 

XAMPP adalah perangkat lunak berupa web server lokal yang 

mendukung banyak sistem operasi, merupakan kompilasi dari 

beberapa program. Fungsinya adalah sebagai server yang berdiri 
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sendiri (localhost), yang terdiri atas program Apache HTTP Server, 

MySQL database, dan penerjemah bahasa yang ditulis dengan 

bahasa pemrograman PHP dan Perl. 

 

6. MySQL 

 

Gambar 10. Database MySQL 

Menurut Winarno (2014), “MySQL adalah sebuah software 

database. MySQL merupakan tipe data relasional yang artinya 

MySQL menyimpan datanya dalam bentuk table-tabel yang saling 

berhubungan. Keuntungan menyimpan data di database adalah 

kemudahannya dalam penyimpanan dan menampilkan data karena 

dalam bentuk tabel.” 

 

7. Visual Studio Code 

 

Gambar 11. Visual Studio Code 

Visual Studio Code (VS Code) adalah sebuah teks editor ringan 

dan handal yang dibuat oleh Microsoft untuk sistem operasi 
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multiplatform, artinya tersedia juga untuk versi Linux, Mac, dan 

Windows. Teks editor ini secara langsung mendukung bahasa 

pemrograman JavaScript, Typescript, dan Node.js, serta bahasa 

pemrograman lainnya dengan bantuan plugin yang dapat dipasang 

via marketplace Visual Studio Code (seperti C++, C#, Python, Go, 

Java, dst). Pada studi kasus ini menggunakan VS Code. 

 

8. Leaflet JS 

 

Gambar 12. Leaflet JS 

Leaflet merupakan open source javascript library yang 

digunakan untuk membuat peta yang sangat interaktif, dimana 

banyak memiliki fitur yang digunakan dalam pembuatan peta. 

Leaflet ini dibuat dengan simpel dan penggunaan yang mudah. 

Leaflet ini juga bisa digunakan baik di dekstop maupun mobile, 

dimana menggunakan HTML 5 dan CSS3 (http://leafletjs.com). 

9. U-Center U-Blox 
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Gambar 13. U-Center U-Blox 

U-center dari u-blox adalah perangkat lunak pusat-U untuk 

evaluasi, analisis kinerja dan konfigurasi penerima GPS. U-center u-

blox dapat menampilkan visualisasi data terstruktur dan grafis 

realtime dari penerima GPS apa pun seperti: 

- Tampilan ringkasan satelit 

- Tampilan ringkasan navigasi 

- Kompas, speedometer, jam, altimeter 

- Tampilan grafik dari dua parameter pilihan 

- Fungsi perekaman dan pemutaran data, dll. 
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Gambar 14. Antarmuka U-Center 

 

Tambahan: 

1. GeoServer 

 

Gambar 15. Basemap Geoserver 

Geoserver merupakan sebuah aplikasi open-source yang 

menyajikan data geospasial melalui layanan web services dan dapat 

diakses melalui website. Geoserver ini menggunakan 2 layanan 

standar yaitu OGC (Open Geospatial Consortium) dan WFS (Web 

Feature Services) dalam menyajikan peta. 
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Geoserver dapat membuat peta dalam berbagai format output, 

OpenLayers, perpustakaan pemetaan gratis dan diintegrasikan ke 

geoserver, dengan ini dapat memudahkan dan mempercepat dalam 

menampilkan sebuat lapisan peta. Geoserver juga dapat 

menampilkan data pada sebuah aplikasi lain seperti: Google Maps, 

Google Earth, Yahoo Maps, dan Microsoft Virtual Earth. selain itu 

geoserver juga dapat terhubung dengan arsitektur GIS seperti ESRI 

GIS (geoserver.org). 

 

2. PostgreSQL (pgAdmin & PostGIS) 

 

 

Gambar 16. pgAdmin & PostGIS 

Database PostgreSQL merupakan salah satu alternatif solusi 

bagi pengguna database yang mendukung banyak platform dan 

bebas lisensi. PostgreSQL dikembangkan oleh University of 

California di Berkeley Computer Science Department. Dengan 

sifatnya yang open source menjadikan pula database ini dapat 

dikembangkan sesuai dengan kebutuhan. 

PgAdmin merupakan tool bawaan yang telah ada saat 

menginstal database PostgreSQL, dengan tampilan yang visual 

menjadikan pemakaian database ini jauh lebih mudah. Sehingga 

tanpa harus menguasai perintah-perintah SQL, tetap dapat membuat 
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objek-objek yang diperlukan hanya dengan menu-menu yang ada 

dari pgAdmin. 

PostGIS adalah ekstensi dari PostgreSQL yang bersifat object 

relational database server yang mempunyai kemampuan untuk 

menyimpan fitur SIG dalam database server. postgis mendukung 

dalam pengelolaan objek-objek geografis untuk basis data yang 

relasional objek milik postgresql. 
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BAB 2 

PENGENALAN ARCGIS 10.8 

 

2.1. Pokok Bahasan 

a. Mengetahui dan memahami cara melakukan Rektifikasi. 

b. Memahami proses instalasi Arcgis 10.8. 

c. Mengenali antarmuka ArcMaps 10.8. 

 

2.2. Data Raster dan Rektifikasi 

Data raster yang biasanya diperoleh dari hasil scanning peta, 

foto udara dan citra satelit belum berisi informasi yang menunjukkan 

referensi spasial, baik yang tersimpan di dalam file atau yang 

disimpan sebagai suatu file yang terpisah. Sehingga untuk 

menggunakan beberapa data raster secara bersama dengan data 

spasial yang lain yang sudah ada, diperlukan proses georeferencing 

ke dalam sebuah sistem koordinat yang disebut koreksi spasial.  

Rektifikasi merupakan proses transformasi data, dari data yang 

belum mempunyai koordinat geografis menjadi data yang akan 

mempunyai koordinat geografi (georeferensi). Data yang sudah 

direktifikasi selanjutnya dapat ditumpangsusunkan (overlay) dengan 

beberapa data lain yang sudah terekftifikasi lebih dulu, seperti data 

raster/image (foto udara, citra satelit atau peta scan dengan data 

spasial) di dalam GIS. Untuk keperluan rektifikasi citra satelit, 

dibutuhkan beberapa koordinat titik kontrol lapangan sebagai bagian 

dari titik sekutu. Koordinat titik kontrol lapangan ini dapat diperoleh 

dari pengukuran langsung di lapangan dengan GPS atau interpolasi 



20 
 

dari peta dasar yang sudah ada. Banyaknya titik kontrol yang harus 

Anda buat tergantung pada kompleksitas dari bentuk transformasi 

polynomial yang akan Anda gunakan untuk mengubah dataset raster 

ke dalam koordinat peta. Untuk hasil rektifikasi yang baik, Anda 

harus menyebarkan secara merata titik kontrol dibandingkan dengan 

hanya memusatkannya dalam satu area. Ada beberapa alasan untuk 

melakukan rektifikasi, antara lain:  

a. Untuk membangun basis data sebuah pemodelan SIG. 

b. Untuk identifikasi sampel yang mengacu pada koordinat 

peta. 

c. Untuk membuat peta foto yang berskala tepat. 

d. Untuk keperluan tumpang susun (overlay) sebuah citra 

dengan data vector. 

e. Untuk membandingkan sebuah citra dalam berbagai skala. 

f. Untuk meningkatkan ketepatan hitungan jarak dan luas pada 

citra  

g. Untuk membuat mosaik citra. 

h. Berbagai aplikasi lain yang membutuhkan identifikasi 

sebuah lokasi geografis secara teliti. 

 

Dalam sistem informasi geografis terdapat dua jenis sistem kordinat 

yaitu:  

1. Geographic Coordinate System: Sistem kordinat yang mengaju 

terhadap bentuk bumi yang sesungguhnya yakni mendekati bola 

(ellipse). Posisi objek di permukaan bumi didefinisikan 

berdasarkan garis lintang (latitude) dan garis bujur (longitude). 
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Garis lintang adalah garis vertikal yang mengukur sudut antara 

suatu titik dengan equator/garis khatulistiwa. Sedangkan Garis 

bujur adalah garis horizontal yang mengukur sudut suatu titik 

dengan titik nol bumi yakni Greenwich di London Britania Raya. 

Unit satuan dari GCS adalah derajat.  

 

Gambar 17. Geographic Coordinate System  

(Sumber: Tutorial Arcgis dasar, Bappeda NTB)  

 

2. UTM: sistem kordinat yang mengacu pada bentuk bumi yang 

datar atau planar melalui proyeksi tertentu. Sistem kordinat ini 

dibagi kedalam beberapa zona antara 01 sampai dengan 60 

dengan satuan meter. Pada sistem kordinat ini kordinat bumi 

dibagi menjadi dua yaitu diatas bagian katulistiwa sebagai 

bagian bagian utara dengan simbol (N) serta dibagian selatan 

katulistiwa diberi simbol (S).  
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Gambar 18. UTM  

(Sumber: Tutorial Arcgis dasar, Bappeda NTB)  

 

Gambar 19. Pembagian Zona UTM Wilayah Indonesia 

(Sumber: gispedia.com) 
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Gambar 20. Tampilan Arcgis 

ArcGis merupakan sotfware berbasis Geographic Information 

System (GIS) yang dikembangkan oleh ESRI (Environment Science 

& Research Institue). ArcGis pertama kali diluncurkan kepada 

publik sebagai software yang komersial pada tahun 1999 dengan 

versi (ArcGis 8.0).  Pada versi terbarunya, ArcGis Deskstop 

memiliki beberapa fitur diantaranya:  

1) ArcMap, yaitu aplikasi utama yang digunakan dalam 

pengelolahan data GIS. ArcMap memiliki kemampuan untuk 

visualisasi, editing, pembuatan peta tematik, pengelolaan dari 

data tabular (Excel), memilih (Query), menggunakan fitur 

Geoprocessing untuk menganalisa dan customize data ataupun 

melakukan output berupa tampilan peta. Operator juga dapat 

mengolah data sesuai dengan keinginannya.  

2) ArcGlobe, merupakan salah satu aplikasi yang memiliki 

tampilan seperti GoogleEarth yang memiliki fungsi sebagai 

tampilan datum permukaan bumi dengan menggunakan citra 

satelit.  
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3) ArcCatalog, yaitu merupakan aplikasi yang memiliki fitur untuk 

membuat data vector dan mengelompokannya sesuai dengan 

fungsi yang diinginkan. Dengan kemampuan tools untuk 

menjelajah informasi (browsing), mengatur data (organizing), 

membagi data (distribution) dan mendokumentasikan data 

spasial maupun data – data berkaitan dengan informasi 

geografis.  

4) ArcScene merupakan aplikasi yang memiliki fitur serupa dengan 

ArcMap, tetapi kelebihannya terdapat dari fitur 3D yang 

digunakan dimana worksheetnya dapat diolah dengan tampilan 

X, Y, dan Z. 

 

2.3. Instalasi ArcGIS 

Pada kali ini kita menggunakan Arcgis 10.8. Adapun cara 

instalasinya adalah sebagai berikut: 

1) Siapkan File Arcgis 10.8 yang sudah didownload. 

2) Install Arcgis_Desktop_108. 

3) Lalu akan muncul tampilan seperti dibawah ini. 
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4) Disini Arcgis memilih folder instalasi. Biarkan saja Lalu Klik 

Next. Silakan tunggu sampai proses selesai. 

 

5) Lalu klik Close. Dan ceklis Lunch the setup program. 
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6) Tunggu sampai tampilan seperti dibawah. Lalu klik Next. 

 

7) Selanjutnya muncul tampilan Master Agreement. Silakan pilih 

I accept the master agreement. Lalu klik Next. 
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8) Selanjutnya muncul tampilan select Instalation Type. 

Complete : menginstal semua fitur aplikasi Arcgis. 

Custom : hanya beberapa fitur aplikasi Arcgis sesuai opsi yang 

dipilih.  
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9) Silakan pilih Complete lalu klik Next. Lalu muncul tampilan 

destination folder. Klik Next saja. 

 

10) Lalu muncul tampilan python destination folder. Dimana disini 

memilih folder python berada. Lalu klik Next. 

 

11) Lalu muncul tampilan Ready to install program. Klik Install 

untuk menginstal aplikasi Arcgis. Dan tunggu proses 

instalasinya sampai selesai. 
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12) Apabila muncul tampilan dibawah ini maka instalasi Acrgis. 
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13) Lalu klik Ok. 

 

14) Klik OK   

  

15) Lalu kita pindahkan file Afcore.dll yang ada pada folder crack 

ke folder C:\Program Files (x86)\ArcGIS\Desktop10.8\bin. 

Lalu pilih replace dan Continue.  
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16) Instal Acrgis selesai.  

 

2.4. Instalasi ArcMap 

ArcMap adalah salah satu software yang dikembangkan oleh 

ESRI (Environment Science & Research Institue) yang merupakan 

kompilasi fungsi-fungsi dari berbagai macam software GIS yang 

berbeda seperti GIS desktop, server, dan GIS berbasis web. ArcMap 

Desktop mempunyai dua software utama yaitu ArcMap dan 

ArcCatalog. ArcMap mempunyai fungsi-fungsi untuk pembuatan 

peta, perbaikan, dan analisa-analisa spasial. Sedangkan ArcCatalog 

mempunyai fungsi-fungsi untuk pendesainan basis data dan 

pengelolaan data. 

a. Memulai ArcMap  

Untuk menjalankan program ArcMap, klik Start dari Windows 

Taskbar, kemudian klik All Programs dan pilih ArcMap →  

ArcMap 10.1. Maka akan masuk ke ArcMap-Getting Started, 

yang perlu diperhatikan yaitu :  

1) Pilih New Map.  

2) Klik Blank Map  

3) Klik explorer →  Buat folder khusus untuk membuka peta dan 

menyimpanan peta. 
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Gambar 21. Tampilan New File 

4) Setelah program ArcMap tampil di layar monitor, anda dapat 

memulai menggunakannya dengan membuka proyek peta 

(maps) yang sudah ada ataupun membuat proyek baru. Anda 

dapat membuat proyek peta baru yang benar-benar kosong atau 

memulainya dengan menggunakan template yang telah 

disediakan. Untuk membuat proyek peta baru, pilih Blank Map 

lalu atur penyimpanan dan tekan tombol OK.  
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b. Antarmuka ArcMap  

 

Gambar 22. Antarmuka ArcMaps 

1) Tool bar = Sekumpulan perintah berbasis ikon/ tombol 

untuk melakukan tugas-tugas tertentu. Tools 

dikelompokkan ke dalam grup-grup misalnya, Menu, 

Tools, Layout, 3Danalyst, dll.  

2) TOC (Table Of Content) = Table Of Content / daftar isi 

Memuat layer-layer yang digunakan dalam project. List 

layer bisa berisi berbagai macam format data. Contohnya 

Data Vektor (Shapefile) dan Data Raster (Data Citra 

Satelit), geodatabase, table dbf.  

3) View / Map = Tampilan Peta yang ada pada layers 

content. 

4) Floating Bar = Semua tools yang dapat dipindahkan. 

Default dari Arc map yaitu Content dan Search. Content 

berguna untuk penggunaan directory penyimpanan dan 

pemanggilan data, baik shapefile maupun data citra 
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satelit. Search berguna untuk mencari tool, modul dll 

yang dibutuhkan secara cepat. 

 

2.5. Rektifikasi dengan Arcgis 

1) Siapkan data gambar peta yang akan kita rektifikasi. 

2) Klik Start Windows pilih folder Arcgis dan klik ArcMaps 10.8. 

 

3) Pilih blank map untuk membuat layout kosong lalu klik ok. 
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4) Selanjutnya kita kan melakukan koneksi ke folder yang 

menyimpan gambar peta yang akan kita rektifikasi. Dengan cara 

klik catalog biasanya ada di samping atau diatas. Atau bisa juga 

dengan klik windows lalu klik catalog. Lalu nanti akan muncul 

halaman catalog. 

 

5) Selanjutnya klik folder yang ada tanda tambahnya . 
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6) Lalu kita pilih folder yang menyimpan peta yang akan 

direktifikasi. Lalu klik OK. 

 

7) Selanjutnya kita akan menentukan system kordinat terlebih pada 

mapview. Pada jendela Table of Content klik kanan pada layers 

lalu klik properties  

 



37 
 

8) Pada jendela Data frame Properties pilih tab coordinat system. 

Disini kita akan menggunakan zona UTM dengan datum WGS 

1984, karena wilayah bogor ada dizona 48S maka kita setting 

48S. Lalu klik Project Coordinate System.  

 

9) Lalu klik UTM  

 

10) Lalu klik WGS 1984 → Southern Hemisphere → WGS 1984 

UTM Zone 48S lalu klik Apply → OK. 
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11) Selanjutnya kita akan menambahkan data peta yang akan kita 

rektifikasi. Pada Jendela Table of content klik kanan Layers 

lalu klik Add data. 
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12)  Lalu cari gambar peta yang akan direktifikasi. Lalu klik Add. 

 

13) Lalu klik OK. 

 

14) Selanjutnya kita akan mengaktifkan fitur Georeferencing. Lalu 

klik Customize → Toolbars → Georeferencing. 
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15) Pastikan nama file pada jendela georeferencing sudah benar.  

 

Dalam rectify dibutuhkan titik kontrol yang akan dijadikan acuan 

dalam proyeksi, setidaknya memiliki 3 atau 4 titik Kontrol, dalam 
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contoh akan membuat 3 titik kontrol, cara membuat titik control 

yaitu: Gunakan zoom untuk menempatkan wilayah yang ingin dibuat 

titik, lalu lihat nilai koordinat titik tersebut dalam peta.  

 

16) Pertama kita harus mengetahui titik kontrol yang akan dijadikan 

acuan pada proyeksi.  

 

Dapat diketahui bahwa nilai UTM pada titik kontrolnya adalah X: 

699100, Y: 9278990. 
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17) Setelah kita mengetahui titik kontrol acuan proyeksi. 

Selanjutnya. Kita klik tanda perbesar pada toolbar.  

 

18) Selanjutnya kita seleksi pada tanda panah merah dan perbesar  

 

19) Lalu pilih simbol add control point pada jendela 

georeferencing.  

  

20) Lalu klik kanan pada titik tengah panah merah. Ketika sudah 

muncul tanda panah hijau lalu klik kiri pada mouse dan pilih 

input X and Y. 
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21) Lalu masukan titik X dan Y yang telah kita ketahui sebelumnya. 

Klik OK . 

 

22) Apabila Maps Administrasi Kota Bogor nya hilang. Silakan 

klik kanan pada layer Administrasi Kota Bogor, lalu klik zoom 

to layers  

 

23) Apabila sudah ada tanda panah merah besar dan ada tulisan 

angka 1, berarti kita sudah berhasil memberikan titik kontrol 

acuan untuk proyeksi. 
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24) Selanjutnya kita akan menambahkan titik kontrol kedua. 

 

Dari gambar diatas dapat diketahui titik X: 693100, dan Y: 9278990 

Lakukan prosesnya seperti pada titik kontrol pertama.  

25) Kita berhasil untuk menambahkan add point kontrol kedua. 
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26) Selanjutnya kita akan menambahkan titik kontrol ketiga. 

 

Dapat diketahui nilai X : 696100 dan Y : 9266990. Silakan lakukan 

add point control seperti langkah-langkah pada titik pertama dan 

kedua. 
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27) Kita berhasil menambahkan tiga titik kontrol. 

 

28) Selanjutnya klik view link table pada jendela georeferencing. 

Nanti akan muncul. 

 

Dari gambar diatas dapat diketahui Total RMS errornya sebesar 0. 

Dimana apabila total RMS errornya <= dari 0 maka hasil 

geometricnya lebih baik.  
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29) Kemudian klik georeferencing pada jendela georeferencing. 

 

Dimana apabila kita mengklik update georeferencing kita akan 

mengupdate data titik kordinat terkoreksi pada administrasi-

bogor.jpg. dan apabila kita melakukan rectify data menyimpan file 

baru administrasi-bogor yang sudah ada data titik kordinat 

terkoreksi. Disini akan dilakukan rectify dengan cara klik rectify. 

Silakan pilih lokasi outputnya dan beri nama dan formatnya TIFF 

lalu klik save.  
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30) Selanjutnya kita akan melakukan overlay hasil georeferencing 

dengan data spasial. Overlay adalah kemampuan untuk 

menempatkan grafis satu peta diatas grafis peta yang lain dan 

menampilkan hasilnya di layar komputer atau pada plot. Agar 

dapat melihat hasil rektifikasi benar atau salah. Kita siapkan dulu 

data spasial kota bogor yang berformat .shp (shapefile).  

31) Selanjutnya kita akan membuat data frame baru. klik insert → 

data frame. 

 

32) Lalu kita add layer data raster yang sudah terkoreksi pada data 

frame baru. Klik kanan pada New Data Frame lalu klik add 

data dan pilih data raster yang sudah terkoreksi tadi → klik add. 
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33) Selanjutnya kita tambahkan data spasial kota bogor yang 

berformat .shp pada data frame baru kita. Klik kanan pada New 

Data Frame, lalu klik add data. Lalu pilih data spasial kota 

bogornya, lalu klik add.  
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34) Apabila sudah, lalu pada menu georeferencing klik fit to display 

jendela georeferencing. Dan pastikan pada data yang dipilih 

administrasi-bogor. 

 

35) Apabila data .shp dan .tiff menyatu maka proses rektifikasi 

berhasil dilakukan. 
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BAB 3 

ANALISIS DATA SPASIAL 

 

3.1. Tujuan 

a. Apa yang ada dilokasi, kapan, mengapa, dan bagaimana.  

b. Apa yang akan terjadi dilokasi dimasa depan atau dilokasi 

lain. 

 

3.2. Pengertian Analisis Spasial 

Analisis spasial merupakan kumpulan – kumpulan dari teknik 

yang dapat digunakan untuk melakukan pengolahan data SIG. Hasil 

dari analisis data spasial sangat bergantung dari lokasi atau tempat 

di mana objek sedang dianalisis. Selain itu, analisis spasial juga bisa 

diartikan sebagai teknik – teknik yang dapat digunakan untuk 

meneliti dan juga mengeksplorasi dari sudut pandang keruangan. 

Semua teknik ataupun pendekatan perhitungan secara matematis 

yang berhubungan dengan data keruangan atau spasial dilakukan 

dengan menggunakan fungsi analisis spasial. Analisis spasial adalah 

teknik ataupun proses yang melibatkan beberapa atau sejumlah 

fungsi perhitungan serta evaluasi logika matematis yang dapat 

dilakukan pada data spasial, dalam rangka untuk memperoleh nilai 

tambah, ekstraksi serta informasi baru yang beraspek spasial. 

Analisis spasial cukup luas ruang lingkupnya. Salah satunya terdapat 

pada SIG atau Sistem Informasi Geografis.  
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3.3. Manfaat Analisis Spasial 

Dalam Pengolahan data SIG, analisis spasial dapat digunakan 

untuk memberikan solusi-solusi atas masalah keruangan. Adapun 

manfaat dari analisis spasial ini tergantung dari fungi yang 

dilakukan, berikut ini manfaat dari analisis spasial adalah sebagai 

berikut:  

1) Membuat, memilih, memetakan, dan menganalisis data raster 

berbasis sel.  

2) Melaksanakan analisis data vector atau raster yang terintegrasi.  

3) Mendapatkan informasi baru dari data yang sudah ada.  

4) Memilih informasi dari beberapa layer data.  

5) Mengintegrasikan sumber data raster dengan data vector. 

 

3.4. Fungsi Analisis Spasial 

Menurut Eddy dalam Denih et al (2020), fungsi dari analisis 

spasial yaitu:  

1. Klasifikasi (reclassify), yaitu suatu kegiatan yang 

mengklasifikasikan kembali suatu data hingga pada akhirnya 

menjadi sebuah data spasial yang baru dan berdasarkan pada 

kriteria atau atribut tertentu.  

2. Jaringan atau Network, yaitu sebuah fungsionalitas yang 

merujuk pada data – data spasial titik- titik ataupun garis – 

garis sebagai jaringan yang tidak terpisahkan.  

3. Overlay, merupakan fungsionalitas yang menghasilkan layer 

data spasial baru, di mana layer tersebut merupakan hasil dari 

kombinasi minimal dua layer yang menjadi masukkannya.  
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4. Buffering, adalah fungsi yang akan menghasilkan layer data 

spasial baru dengan bentuk poligon serta memiliki jarak 

tertentu dari unsur – unsur spasial yang menjadi 

masukkannya.  

5. 3D Analysis, fungsi ini terdiri atas sub – sub fungsi yang 

berkaitan dengan presentasi data spasial yang terdapat di 

dalam ruang 3 dimensi atau permukaan digital.  

6. Digital Image Processing, untuk fungsionalitas ini nilai 

ataupun intensitas dianggap sebagai fungsi sebar atau 

spasial.  

 

3.5. Jenis-Jenis Analisis Spasial 

1) Query basis data 

Query basis data sendiri digunakan untuk memanggil atau 

mendapatkan kembali atribut sebuah data tanpa harus 

mengganggu atau mengubah data yang sudah ada sebelumnya. 

Fungsi dari query basis data yaitu dapat dilakukan dengan cukup 

mudah, cukup menekan feature yang diinginkan. Namun, untuk 

query yang lebih lengkap dan kompleks, dapat menggunakan 

pernyataan kondisional (conditional statement). Pernyataan ini 

ternyata melibatkan beberapa operasi logis yaitu, AND, NOT, 

OR, XOR.  
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2) Pengukuran  

Analisis spasial dapat dilakukan dengan fungsi pengukuran. 

Fungsi pengukuran yang dimaksud adalah sebagai berikut:  

a. Jarak: Fungsi ini digunakan untuk menentukan jarak antara 

dua titik (unsur spasial) yang di dapat dilakukan dengan 

mengklik kedua titik tersebut atau dapat juga menggunakan 

query.  

b. Luas: Fungsi luas ini dapat digunakan untuk menghitung 

luas suatu wilayah unsur – unsur spasial. Wilayah tersebut dapat 

berupa polygon (vector) ataupun juga wilayah yang bertipe 

raster.  

c. Keliling: Fungsi keliling ini digunakan untuk menghitung 

keliling (parameter) unsur – unsur spasial. Unsur – unsur spasial 

tersebut dapat bertipe polygon (vector) dan juga raster.  

d. Centroid: Fungsi digunakan untuk menentukan kordinat (x, 

y) titik pusat dari unsur – unsur spasial yang bertipe polygon 

(vektor).  

e. PIP (Point in Poligon): Fungsi yang digunakan untuk 

mementukan apakah suatu titk terdapat didalam atau diluar unsur 

yang bertipe polygon (vector).  

f. LOF (Line of Sight): Fungsi ini digunakan untuk 

mengetahui apakah kedua lokasi diatas permukaan digital bisa 

terlihat satu sama lain.  

g. Cut and fill: Fungsi ini digunakan untuk menghitung volume 

galian/tumbuhan dengan membandingkan data permukaan datar 

dengan ketinggian tertentu sebagai referensi.  
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3) Fungsi Kedekatan (Proximity)  

Fungsi kedekatan adalah sebuah fungsi untuk menghitung jarak 

dari suatu titik, garis, ataupun batas polygon. fungsi ini 

digunakan untuk menghitung beberapa hal antara lain:  

a. Membuat sempadan baik pada jalan, bangunan sungai dan 

lain-lain.  

b. Membuat zona-zona penyangga (buffer) untuk berbagai 

macam kerperluan.  

c. Menghitung jarak terdekat maupun terjauh dari suatu lokasi 

ataupun area, dan lain-lain.  

 

Salah satu fungsi kedekatan yang paling banyak digunakan 

adalah buffer. Buffer adalah analisis spasial yang akan 

menghasilkan unsur – unsur spasial yang bertipe polygon. 

Dimana buffer ini membuat polygon penyangga di sekitar fitur 

input ke jarak yang ditentukan. Secara garis besar analysis buffer 

terbagi atas 2, yakni buffer dan Multiple Ring Buffer.  

1. Buffer: untuk membuat polygon penyangga disekitar fitur 

input ke jarak yang ditentukan Contoh kasus dari buffer 

adalah membuat zonasi radius bencana, dan pelebaran jalan. 

Ilustrasinya dapat dilihat digambar bawah ini.  
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Gambar 23. Buffer 

(Sumber: desktop arcgis) 

 

2. Multi Ring buffer: digunakan saat harus melakukan 

beberapa kali buffer dalam fitur. Ilustrasinya dapat dilihat 

digambar bawah ini.  

 

Gambar 24. Multi Ring Buffer 

(Sumber: desktop arcgis) 
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4) Overlay  

Overlay adalah bagian penting dari analisis spasial. Overlay 

dapat menggabungkan beberapa unsur spasial menjadi unsur 

spasial yang baru. Dengan kata lain, overlay dapat didefinisikan 

sebagai operasi spasial yang menggabungkan layer geografik 

yang berbeda untuk mendapatkan informasi baru. Overlay dapat 

dilakukan pada data vector maupun raster. Overlay terdiri atas 

beberapa model analisis antara lain Identity, Intersect, union dll.  

 

 

Gambar 25. Intersect (Kiri), Identity (Kanan) dan Union 

(bawah) 

 

5) Pengubahan Unsur – unsur spasial  

a. Union, Merge atau Combine  

Pada pengolahan data SIG, seringkali harus melakukan 

penggabungan antar unsur – unsur spasial. Penggabungan 

tersebut dapat menggunakan analisis spasial yaitu union, 
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merge, atau combine. Penggabungan ini dapat menjadikan 

beberapa unsur spasial menjadi satu unsur spasial tanpa 

mengubah beberapa unsur spasial yang digabungkan 

tersebut.   

Union: menghasilkan output berupa geometris dari kedua 

polygon input. Contoh kasusnya adalah menggabungkan 

data jalan antar kecamatan. Ilustrasi gambarnya dapat dilihat 

pada gambar 25.  

 

Merge: menghasilkan output yang merupakan gabungan dari 

beberapa input (seperti, point, polygon, line) dari tipe data 

yang sama. Contoh kasusnya menggabungkan daerah 

kecamatan.  

 

b. Delete, Erase, atau cut  

Fungsi analisis spasial digunakan untuk menghapus unsur – 

unsur spasial yang dirasa tidak perlu ditampilkan. Fungsi ini 

hanya akan menghapus unsur – unsur spasial yang terpilih 

saja. Contoh kasusnya membuat area yang tidak terdampak 

bencana alam seperti banjir. Ilustrasinya dapat dilihat di 

gambar dibawah ini.  
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Gambar 26. Delete, Erase or Cut Feature 

(Sumber: pro arcgis) 

 

c. Split atau Clip  

Fungsi analisis spasial ini bertujuan untuk menghasilkan 

unsur spasial baru dengan cara memotong dari unsur spasial 

lainnya. Contoh Penggunaan Clip. 

 

Gambar 27. Split or Clip Feature 

(Sumber: pro arcgis) 

 

d. Intersect  

Intersect adalah sebuah fungsi pada analisis spasial untuk 

menghasilkan unsur spasial baru dari dua atau lebih spasial. 

Fungsi ini menghasilkan unsur spasial baru dari irisan dua 

atau lebih unsur spasial sebelumnya. Contoh kasusnya 
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membuat analisis spasial yang menghasilkan informasi 

bangunan yang terdampak bencana alam. Ilustrasinya dapat 

dilihat pada gambar 25. 

 

e. Dissolve  

Fungsi analisis spasial yang melakukan agregasi unsur-unsur 

spasial yang memiliki kesamaan atribut. Dimana Output 

yang dihasilkan adalah agregasi fitur berdasarkan atribut 

yang ditentukan. Contohnya mengetahui batas kecamatan 

dari shapefile batas desa. Ilustrasinya dapat dilihat digambar 

dibawah ini  

 

Gambar 28. Dissolve 

(Sumber: pro arcgis) 
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3.6. Studi Kasus Analisis Spasial 

a. Bagaimana cara mengetahui batas sebuah kecamatan dari shape 

file batas kelurahan? 

• Tools analysis: dissolve. 

• Berikut langkah-langkahnya:  

1) Tambahkan data spasial Add data, kelurahan.shp. 

 

Maka hasilnya akan seperti ini: 
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2) Pastikan layer kelurahan.shp aktif, lalu pada catalog, pilih 

toolboxes → system toolboxes → data management tools.tbx → 

generalization dan pilih Dissolve. 

 

3) Double klik pada dissolve, pada Input Features masukan file 

kelurahan.shp, Output featuresnya di beri nama 

kecamatan_dissolve.shp, lakukan dissolve pada kecamatan 

dengan ceklis Field Kecamatan pada Dissolve_fields, lalu klik 

ok. 
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Sehingga hasilnya seperti ini: 

 

4) Dari gambar diatas kita dapat melihat batasan dari kecamatan 

pada file shp kelurahan, dapat dilihat perbandingan sebelum dan 

setelah dilakukkan proses dissolve. Selain itu, atribut yang 

dihasilkan oleh proses dissolve akan berubah seperti gambar 

dibawah. 
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b. Bagaimana Karakteristik Penggunaan Lahan di Kecamatan A? 

• Tool analysis: Clip, calculate geometry. 

• Berikut langkah-langkahnya:  

1) Tambahkan data spasial Add data, Landuse_Bdg_25K.shp dan 

Adm_Kec_Bdg_25K.shp lalu klik Add 

 

 

2) Karena dalam data Adm_Kec_Bdg_25K.shp adalah data seluruh 

kecamatan yang ada di Bandung. Maka kita batasi hanya 

menggunakan satu kecamatan, yaitu kecamatan Batununggal.  
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Data yang terseleksi adalah data Kecamatan Batununggal. 

Selanjutnya adalah mengambil data Kecamatan Batununggal 

tersebut. Yaitu klik Tools Select  Feature. Kemudian klik kanan 

pada layer → Klik Data → Klik Export Data. Lalu muncul tampilan 

seperti ini. Beri nama “kecamatan_batununggal.shp” dan simpan di 

folder 01_ShapeFile. Lalu klik OK.  

 

3) Apabila tampil dialog untuk menampilkan hasil ke Table of 

Content, klik OK.  
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Pada Table of Content, Aktifkan hasil export 

kecamatan_batununggal.shp untuk melihat hasilnya.  

4) Selanjutnya lakukan analisis data dgn cara, klik Catalog, pilih 

Toolboxes → System Toolboxes → Analysis Tools → Extract 

→ Lalu pilih Clip dengan cara men-double klik.  

 

5) Pada jendela Clip, masukan Landuse_Bdg_25K.shp pada input 

feature dan kecamatan_batununggal.shp pada clip feature. 

6) Output feature simpan pada folder 03_Analysis, beri nama  

Landuse_Kecamatan_Batununggal.shp. Kemudian Klik OK.  



68 
 

 

Aktifkan hanya pada layer Landuse_Kecamatan_Batununggal.shp 

untuk melihat hasil Clip secara jelas seperti gambar di atas ini.  

7) Tambahkan luas area pada data atribut  

a. Pada jendela Table of content, klik kanan pada layer data lalu 

pilih open attribute table. 

b. Pada Jendela Table, pilih Table Option lalu pilih add field. 

c. Pada jendela add field, tulis nama field Area_ha, Type data: 

Float, klik ok.  
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d. Kemudian pada Attribute table, klik kanan pada field 

luas_ha, pilih calculate geometry, kemudian pada Property 

pilih Area unit Square Hectare(ha)  

 

Keterangan: Gambar diatas adalah hasil dari Calculate Geometri. 

Calculate Geometri adalah salah satu fungsi yang disediakan oleh 

Arcmap untuk menghitung luas wilayah geometri.  

8) Untuk melihat karakteristik penggunaan lahan di Kecamatan 

Batununggal, selanjutnya adalah buat pivot table di Ms. Excel 

dan buka data Landuse_Kecamatan_Batununggal.dbf  
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a. Buka Ms. Excel → Buka file 

Landuse_Kecamatan_Batununggal.dbf → seleksi semua 

datanya → Klik Menu Insert → Pivot Table. Pada tampilan 

dialog, klik OK. 

 

Gambar diatas adalah hasil dari Pivottable. Sehingga 

diketahui, karakteristik penggunaan lahan di Kecamatan 

Batununggal adalah untuk air tawar, gedung, pemukiman, 

rumput, sawah irigasi dan tegalan/lading.  
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c. Misal terdapat usaha industry di wilayah Kab. Bogor yang 

limbahnya berdampak pada daerah perbatasan di Kota Bogor, 

berapa besar area wilayah yang terkena dampak itu? 

• Tools analysis: Intersect, calculate geometry  

• Berikut langkah-langkahnya:  

1) Tambahkan data spasial Add data, kelurahan.shp, dan 

efek_industry.shp yang ada di folder Data Kota Bogor. Lihat 

attribute masing-masing untuk mempermudah memahami hasil 

dari proses ini.  

2) Pada Arctoolbox, pilih Analysis Tools → Overlay → Intersect, 

maka akan muncul jendela Intersect.  

3) Tambahkan data efek_industri.shp dan kelurahan.shp, simpan 

Outputnya di folder 03_Analisis dengan nama 

Efek_Industri_KotaBogor.shp. Klik OK.  
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4) Aktifkan layer hasil dari Intersect, sedangkan yang lain di 

nonaktifkan.  Untuk memperjelas hasil dari fungsi Intersect 

silakan lihat atributnya.  

  

 

5) Tambahkan luas area pada data atribut. 

a. Pada jendela Table of content, klik kanan pada layer data lalu 

pilih open attribute table. 

b. Pada Jendela Table, pilih Table Option lalu pilih add field. 

c. Pada jendela add field, tulis nama field Area_ha, Type data: 

Float, klik ok. 

d. Kemudian pada Attribute table, klik kanan pada field 

luas_ha, pilih calculate geometry, kemudian pada Property 

pilih Area unit Square Hectare(ha). 
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Gambar diatas menunjukkan bahwa kelurahan yang terkena 

dampak limbah industry yang ada di Kab. Bogor adalah 

Kelurahan Pasirmulya, dan Kelurahan Loji.  

 

d. Hitung luas wilayah per kecamatan yang ada dalam radius 10 

km, 15 km, dan 20 km dari Gunung Tangkuban Parahu?  

• Tools analysis: Buffer, Intersect, calculate geometry  

• Berikut langkah-langkahnya:  

1) Tambahkan data spasial Add data, volcano.shp, 

Adm_Kec_Bdg_25K.shp, tangkuban_perahu. 

 

2) Aktifkan selection pada layer titik Gunung Tangkuban Parahu, 

biarkan tetap aktif. 

3) Pada Arctoolbox, pilih Analysis Tools → Proximity → Multiple 

Ring Buffer, maka akan muncul jendela Multiple Ring Buffer. 
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4) Aktifkan layer tangkuban_parahu, lalu Pada jendela Multiple 

Ring Buffer masukkan volcano.shp pada input feature, dan buat 

nama file/layer tangkuban_parahu_buff.shp pada Output Feature 

Class. Output feature simpan pada folder 03_Analysis.       

a. Pada Distance masukkan nilai 10 lalu klik add, 15 lalu klik 

add, dan 20 lalu klik add. 

b. Pada Buffer Unit Pilih unit kilometers (km). 

c. Pada Dissolve Option pilih All, lalu Klik Ok.  
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Maka hasilnya akan seperti ini: 

 

 

5) Pilih layer tangkuban_parahu_buff, lalu Pada Arctoolbox, pilih 

AnalysisTools  
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     → Overlay → Intersect, maka akan muncul  

     jendela Intersect. 

a. Pada jendela Intersect, masukkan 

tangkuban_parahu_buff.shp pada input feature kemudian 

Adm_Kec_Bdg_25K.shp pada input feature.  

b. Pada Output Feature Class buat nama file 

kec_tangpar_buff_inters.shpOutput feature simpan pada 

folder 03_Analysis.  
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Maka hasilnya akan seperti ini: 

 

6) Tambahkan luas area pada data atribut. 

a. Pada jendela Table of content, klik kanan pada layer data lalu 

pilih open attribute table. 

b. Pada Jendela Table, pilih Table Option lalu pilih add field. 

c. Pada jendela add field, tulis nama field Area_ha, Type data: 

Float, klik ok.  

d. Kemudian pada Attribute table, klik kanan pada field 

Area_ha, pilih calculate geometry, kemudian pada Property 

pilih Area unit Square Hectare(ha). 
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Dari gambar diatas, dapat diketahui luas wilayah per kecamatan pada 

setiap radius yang ditentukan (10, 15, 20) km. dapat diketahui pula 

radius wilayah dengan kecamatan terbanyak adalah pada radius 

20km dari gunung tangkuban parahu. 
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BAB 4 

TEKNIK PENGUMPULAN DATA 

 

4.1. Tujuan 

a. Memahami teknik pengumpulan data. 

b. Melakukan koleksi data secara langsung. 

c. Melakukan koleksi data secara tidak langsung. 

 

4.2. Pengertian Pengumpulan Data 

Ada 5 cara untuk memperoleh data geografi, adalah sebagai 

berikut: 

1) Survei Lapangan: pengukuran fisik (land marks), 

pengambilan sampel (polusi air), pengumpulan data non-

fisik (data sosial, politik, ekonomi dan budaya). 

2) Sensus: dengan pendekatan kuesioner, wawancara dan 

pengamatan; pengumpulan data secara nasional dan periodik 

(sensus jumlah penduduk, sensus kepemilikan tanah). 

3) Statistik: merupakan metode pengumpulan data 

periodik/per-interval-waktu pada stasiun pengamatan dan 

analisis data geografi tersebut, contoh: data curah hujan. 

4) Tracking: Merupakan cara pengumpulan data dalam periode 

tertentu untuk tujuan pemantauan atau pengamatan 

perubahan, contoh: kebakaran hutan, gunung meletus, debit 

air sungai. 

5) Penginderaan jarak jauh (inderaja): merupakan ilmu dan seni 

untuk mendapatkan informasi suatu obyek, wilayah atau 
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fenomena melalui analisis data yang diperoleh dari sensor 

pengamat tanpa harus kontak langsung dengan obyek, 

wilayah atau fenomena yang diamati (lillesand & kiefer 

dalam Denih et al, 2020). 

 

Menurut Paryono dalam Denih et al (2020), sistem informasi 

geografi memerlukan data masukan agar dapat berfungsi dan 

memberikan informasi hasil analisisnya. Data masukan tersebut 

dapat diperoleh dari berbagai sumber, antara lain yaitu: data 

lapangan, GPS, peta analog dan citra penginderaan jauh. 

A. Peta analog 

Peta analog adalah peta dalam bentuk cetakan. Pada umumnya 

peta analog dibuat dengan teknik kartografi, sehingga sudah 

mempunyai referensi spasial seperti koordinat, skala, arah mata 

angin dsb. Peta analog dikonversi menjadi peta digital dengan 

berbagai cara yang akan dibahas pada bab selanjutnya. Referensi 

spasial dari peta analog memberikan koordinat sebenarnya di 

permukaan bumi pada peta digital yang dihasilkan. Biasanya peta 

analog direpresentasikan dalam format vektor. 

Informasi yang lebih terekam pada peta kertas atau film, 

dikonversikan ke dalam bentuk digital, misalnya peta geologi, peta 

tanah dan sebagainya. Lebih lanjut dinyatakan oleh Karsidi dalam 

Denih et al (2020), bahwa untuk mengubah data peta menjadi data 

sistem informasi geografi digital, maka ada dua proses yang dapat 

dilakukan yaitu melalui digitasi garis dan penyapuan (scanning). 
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Dengan digitasi maka obyek – obyek di peta digambarkan ulang 

dalam bentuk digital menggunakan peralatan meja digitasi.  

Meja digitasi adalah alat perekam koordinat yang akan mencatat 

posisi dari kursor yang dipakai untuk menggambar ulang obyek peta. 

Dilain pihak dengan teknik scanning, maka obyek – obyek peta 

direkam ulang dengan alat optik (semacam mesin foto copy) yang 

kemudian akan mengubah data rekaman gambar ke dalam format 

raster. Memilih kerangka peta berkaitan erat dengan pemilihan 

proyeksi peta yang akan digunakan, karena perbedaan lokasi di 

permukaan bumi, luas area yang dikaji dalam SIG, bentuk area yang 

dikaji perlu dipertimbangkan pada saat memilih jenis proyeksinya. 

Disamping memilih jenis proyeksi, yang tidak kalah pentingnya 

dalam pembicaraan mengenai peta sebagai kerangka SIG, usaha – 

usaha untuk dapat mentransfer data suatu titik ke posisi ke dalam 

jenis proyeksi satu ke lainnya. 

 

B. Data dari sistem Penginderaan Jauh 

Data Penginderaan Jauh dapat dikatakan sebagai sumber data 

yang terpenting bagi SIG karena ketersediaannya secara berkala. 

Dengan adanya bermacam-macam satelit di ruang angkasa dengan 

spesifikasinya masing-masing, kita bisa menerima berbagai jenis 

citra satelit untuk beragam tujuan pemakaian. Data ini biasanya 

direpresentasikan dalam format raster, antara lain citra satelit, foto 

udara, dsb. 

Citra penginderaan jauh yang berupa foto udara atau dapat 

diinterpretasi terlebih dahulu sebelum dikonversi kedalam bentuk 
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digital. Sedangkan citra yang diperoleh dari satelit yang sudah dalam 

bentuk digital dapat langsung digunakan setelah diadakan koreksi 

seperlunya. Lebih lanjut dinyatakan ketiga sumber tersebut saling 

mendukung satu terhadap yang lain. Data lapangan dapat digunakan 

untuk membuat peta fisik, sedangkan data penginderaan jauh juga 

memerlukan data lapangan untuk lebih memastikan kebenaran data 

tersebut. Jadi ketiga sumber data saling berkaitan, melengkapi dan 

mendukung, sehingga tidak boleh ada yang terabaikan. 

Data yang belum dalam bentuk digital dapat diubah menjadi 

bentuk digital dengan cara manual, yaitu mengubah informasi 

geografis menjadi data digital dengan sistem kisi – kisi (grid atau 

raster system). Cara manual lain namun lebih maju adalah dengan 

menggunakan digitizer, sedangkan yang otomatis menggunakan 

scanner. Untuk cara manual diperlukan ketelitian operator yang 

mengkonversi data, sehingga data yang diperoleh masih sesuai 

(mendekati) seperti aslinya. Sedangkan untuk penggunaan scanner, 

perlu diperhatikan resolusi scanner yang digunakan agar data yang 

tersimpan tidak banyak mengalami kehilangan detilnya atau 

mengalami degradasi resolusi. 
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C. Data hasil pengukuran lapangan 

Data ini diperoleh langsung dari pengukuran lapangan secara 

langsung, seperti pH tanah, salinitas air, curah hujan, jenis tanah, dan 

sebagainya. Karsidi dalam Denih et al (2020) mengemukakan, 

bahwa yang termasuk data lapangan yaitu data sosial ekonomi yang 

dapat diperoleh dari terbitan resmi maupun catatan oleh badan resmi 

baik pemerintah maupun swasta. Data dapat diperoleh melalui cara 

sensus ataupun survei (sampel). Contoh data hasil pengukuran 

lapang adalah data batas administrasi, batas kepemilikan lahan, batas 

persil, batas hak pengusahaan hutan, dsb., yang dihasilkan 

berdasarkan teknik perhitungan tersendiri. Pada umumnya data ini 

merupakan sumber data atribut. 

 

D. Data GPS 

Teknologi GPS memberikan terobosan penting dalam 

menyediakan data bagi SIG. Keakuratan pengukuran GPS semakin 

tinggi dengan berkembangnya teknologi. Data ini biasanya 

direpresentasikan dalam format vektor. Winarno dan Suryono 

(1994) mengemukakan, bahwa ada tiga jenis sumber data yang 

dipakai dalam sistem informasi geografi yaitu: 

1) Data spasial berbentuk vektor. Data ini bersumber dari peta 

topografi dan peta tematik lainnya. 

2) Data spasial berbentuk raster. Data ini bersumber dari hasil 

rekaman satelit atau pemotretan udara. 
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3) Data alphanumerik. Data ini bersumber dari catatan statistik 

atau sumber lainnya, yang sifatnya sebagai deskripsi 

langsung atau sebagai tambahan dari data spasial. 

Lebih lanjut dinyatakan oleh Paryono dalam Denih et al (2020), 

bahwa pada model raster, semua obyek disajikan dalam bentuk sel – 

sel yang disebut pixel (picture element). Setiap sel memiliki 

koordinat serta informasi (atribut keruangan dan waktu). Obyek 

dalam bentuk titik, garis, maupun bidang (area) semuanya disajikan 

dan dinyatakan dalam titik atau sel, sedangkan pada model vektor, 

obyek disajikan sebagai titik atau segmen – segmen garis. Lebih 

lanjut dikemukakan oleh Karsidi dalam Denih et al (2020), untuk 

keperluan analisis keruangan (spasial), sistem informasi geografi 

mempunyai kemampuan analisis spasial yang utama termasuk: 

analisis tumpang tindih (overlay) untuk mengetahui daerah yang 

dilipur oleh dua karakteristik dari tema yang berbeda dan untuk 

mengetahui perubahan batas dari waktu ke waktu; analisis 

sebaran/distribusi dari suatu obyek untuk mengetahui variasi pola 

dan jumlah atribut terhadap ruang; analisis aliran (flow) di dalam 

suatu jaringan untuk menganalisis pola aliran lalu lintas misalnya, 

dan analisis tiga dimensi. (Dalam http://www.oocities.org/). 
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4.3. Instalasi Addons 2007 Office System Driver 

A. Alat dan bahan 

1) Addons 2007 Office System Driver: Data Connectivity 

Components. 

 

B. Metode kerja 

 

Apabila muncul pesan pada saat memasukan data excel seperti 

gambar diatas. Maka, harus menginstal addons 2007 office system 

driver: data connectivity components terlebih dahulu. Secara teknis 

software ArcGIS tidak mempunyai addons yang digunakan untuk 

membaca file Excel format terbaru maupun format lama (2003-

2016) sehingga ketika akan menambahkan data dari Excel harus 

menginstal semacam addons dari Microsoft agar software ArcGIS 

bisa membaca file Excelnya. Hal ini terjadi dikarenakan Office yang 

telah diinstal pada laptop atau komputer adalah office versi terbaru 

semisal office 2016, office 2013, office 365 dan lain sebagainya. 

Tetapi tidak semua komputer atau laptop mengalami hal seperti ini. 

Untuk mengatasi kejadian diatas harus menginstal yang 

namanaya "2007 Office System Driver: Data Connectivity 
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Components". sebelum menginstal addons tersebut diharapkan 

untuk menutup semua ArcGIS yang sedang terbuka. Langkah – 

langkah menginstalnya adalah sebagai berikut:  

2) Silakan download addons 2007 Office System driver: Data 

connectivity Component. 

3) Silakan instal 2007 Office System driver: Data connectivity 

Component dengan mengklik kanan lalu kli run as 

administrator. 

 

4) Lalu muncul tampilan user agreement. Ceklis I accept the terms 

in the license agreement → klik Next. 
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5) Lalu klik install. 

 

6) Setelah proses instalasi selesai silakan klik OK. 
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7) Proses instalasi selesai dilakukan. 

 

4.4. Pengumpulan Data dengan Aplikasi My GPS Cordinates 

A. Alat dan bahan 

1) My GPS Cordinates (Aplikasi Mobile). 

 

B. Metode kerja 

1) Langkah Pertama silakan download aplikasi My GPS 

Cordinates di playstore / Appstore. 
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2) Setelah di download silakan buka aplikasi My GPS Cordinates. 

Survei ini dilakukan langsung terjun kelapangan, sehingga 

kordinat yang didapatkan lebih akurat. Apabila muncul tampilan 

seperti tampilan berikut silakan klik OK. Untuk mengaktifkan 

lokasi handphone. 

 

Lalu muncul tampilan seperti berikut: yang mana menunjukan 

Latitude dan longitude.   
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3) Selanjutnya kita akan memotret lokasi dengan mengklik tanda 

kamera. Lalu poto lokasi, dan klik tanda ceklis 

 

4) Lalu muncul tampilan berikut: 

Keterangan: 

Share : untuk melakukan share gambar  

Edit : Untuk mengedit atau photo ulang 

Save : untuk menyimpan gambar hasil survei 
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5) Lalu Klik Save untuk menyimpan gambar, dan isi nama 

lokasinya. Misalkan disini diberi nama SMPN 8 Kota Bogor. 
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6) Untuk Melihat hasil data yang sudah di save silakan klik saved 

Locations di paling bawah. Maka akan muncul tampilan seperti 

berikut: 

 

Note: data longitude dan latitude itu berupa kordinat UTM. 
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7) Selanjutnya buka Microsoft Excel dan masukan data Longitude 

dan latitude serta informasi lainnya seperti alamat/ nama jalan, 

nama lokasi dan lain-lain. 

 

8) Selanjutnya silakan save file excelnya dalam format .xlsx. 

9) Selanjutnya akan dibuat data .shp untuk data hasil survey yang 

telah dilakukan. Lalu buka Arcmaps. 
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10) Selanjutnya kita akan mengatur zona waktunya. klik kanan 

Layers pada jendela table of contents → Klik properties. 

 

11) Pada jendela Data frame Properties pilih tab coordinat system. 

Disini kita akan menggunakan zona UTM dengan datum WGS 



96 
 

1984, karena wilayah bogor ada dizona 48S maka kita setting 

48S. Lalu klik Project Coordinate System. 

 

12) Lalu klik UTM. 

 

13) Lalu klik WGS 1984 → Southern Hemisphere → WGS 1984 

UTM Zone 48S lalu klik Apply → OK. 
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14) Selanjutnya kita tambahkan data excel hasil survei yang telah 

dilakukan. 

15) Lalu klik file excelnya untuk menambahkan data → klik File → 

klik add data → klik add XY data. 
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16) Lalu klik icon folder untuk mengakses folder data hasil survey 

Note: Koneksikan dulu folder tempat file excelnya. 

 

 

17)  Lalu pilih file excel data hasil survei, kemudian klik add. 
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18) Kemudian pilih sheet data hasil survei, lalu klik add. 

 

19) Data berhasil kita pilih, jangan lupa dicek X Field nya diisi nama 

field excel yang berisi data longitude, dan Y Field nya diisi 

nama field excel yang berisi data latitude. Dan pastikan 

description berisi coordinate system sesuai wilayah data hasil 

survei. Apabila sudah sesuai silakan klik OK. 



100 
 

 

20) Data excel berhasil diimport atau di add. 

 



101 
 

 

21) Selanjutnya kita akan melakukan export data excel menjadi data 

.shp. 

22) Klik kanan pada nama layers yaitu sheets1. → klik Data → klik 

Export Data. 

 

23) Lalu klik icon folder untuk mensetting folder untuk data shpnya. 
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24) Silakan pilih folder dimana anda ingin menyimpan file .shpnya 

lalu klik save. 

 

Note: Namenya diisi: nama filenya. Save as type: Shapefile  

25) Selanjutnya klik OK. 

 

Selanjutnya klik YES. 
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26) Data excel berhasil di export menjadi data .shp. 

 

27) Selanjutnya kita remove data excel nya yaitu file 

sheets1$events. Dengan cara klik kanan pada layers 

sheets1$events → klik remove. 
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28) Data excel berhasil di remove. 

 

29) Selanjutnya save file Arcmapsnya. Dengan cara klik File → save 

as. 
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30) Silakan pilih foldernya yang anda inginkan untuk menyimpan 

file Arcmapsnya lalu klik save.  

Note: save as typenya Arcmap Document (*.mxd) 

 



106 
 

4.5. Pengumpulan Data dengan Google Maps 

A. Alat dan bahan 

1. Aplikasi google maps (Via Mobile phone). 

2. https://www.google.com/maps (Via browser). 

B. Metode kerja 

1) Langkah pertama silakan akses google mapsnya via 

https://www.google.com/maps (Via browser) atau Aplikasi 

google maps (Via Mobile phone). 

2) Pilih lokasi yang akan kita kumpulkan data nya seperti longitude, 

latitude nanti akan muncul marker merah. Survei ini dapat 

dilakukan dirumah tanpa harus ke lapangan, namun ke akuratan 

kordinatnya agak kurang. 

 

Note: data longitude dan latitude itu berupa kordinat UTM 
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3) Selanjutnya buka Microsoft Excel dan masukan data Longitude 

dan latitude serta informasi lainnya seperti alamat/ nama jalan, 

nama lokasi dan lain-lain. 

 

4) Selanjutnya silakan save file excelnya dalam format .xlsx. 

5) Selanjutnya kita akan membuat data shp buat data hasil survey 

yang telah dilakukan. Lalu buka Arcmaps. 
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6) Selanjutnya kita akan mengatur zona waktunya. klik kanan 

Layers pada jendela table of contents → Klik properties  

 

7) Pada jendela Data frame Properties pilih tab coordinat system.  

Disini kita akan menggunakan zona UTM dengan datum WGS 

1984, karena wilayah bogor ada dizona 48S maka kita setting 

48S. Lalu klik Project Coordinate System. 
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8) Lalu klik UTM 

 

9) Lalu klik WGS 1984 → Southern Hemisphere → WGS 1984 

UTM Zone 48S lalu klik Apply → OK. 
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10) Selanjutnya kita tambahkan data excel hasil survei yang telah 

dilakukan. 

11) Lalu klik file excelnya untuk menambahkan data → klik File → 

klik add data → klik add XY data. 

 



111 
 

 

12) Lalu klik icon folder untuk mengakses folder data hasil survey 

Note: Koneksikan dulu folder tempat file excelnya, 
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13)  Lalu pilih file excel data hasil survei, kemudian klik add. 

 

14) Kemudian pilih sheet data hasil survei, lalu klik add. 

 

15) Data berhasil kita pilih, jangan lupa dicek X Field nya diisi nama 

field excel yang berisi data longitude, dan Y Field nya diisi 

nama field excel yang berisi data latitude. Dan pastikan 
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description berisi coordinate system sesuai wilayah data hasil 

survei. Apabila sudah sesuai silakan klik OK. 

 

16) Data excel berhasil diimport atau di add. 
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17) Selanjutnya kita akan melakukan export data excel menjadi data 

.shp. 

18) Klik kanan pada nama layers yaitu sheets1. → klik Data → klik 

Export Data. 

 

19) Lalu klik icon folder untuk mensetting folder untuk data shpnya. 
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20) Silakan pilih folder dimana anda ingin menyimpan file .shpnya 

lalu klik save. 

 

Note: Namenya diisi: nama filenya. Save as type: Shapefile. 

21) Selanjutnya klik OK. 
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22) Selanjutnya klik YES. 

 

23) Data excel berhasil di export menjadi data .shp. 
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24) Selanjutnya kita remove data excel nya yaitu file 

sheets1$events. Dengan cara klik kanan pada layers 

sheets1$events → klik remove. 
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25) Data excel berhasil di remove. 

 

26) Selanjutnya save file Arcmapsnya. Dengan cara klik File → save 

as. 
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27) Silakan pilih foldernya yang anda inginkan untuk menyimpan 

file Arcmapsnya lalu klik save. 

Note: save as typenya Arcmap Document (*.mxd). 

 

4.6. Pengumpulan Data dengan Shape File 

A. Alat dan bahan 

1. Data .shp kota bogor & Kab. Bogor. 

2. Avenza Maps (Mobile phone). 

B. Metode kerja 

1) Setelah mempelajari digitasi dan georeferencing, buka file yang 

sudah disediakan. 

2) Pilih Layout View pada bagian bawah. 
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3) Untuk membuat grid pada layer, Klik Kanan map lalu pilih 

Properties. 

 

4) Pilih New Grid lalu sesuikan. 
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5) Setelah selesai penyesuaian Grid, silakan pilih File → Export 

Map →  Pilih format PDF. 

 

6) Setelah itu, pindahkan file PDF tersebut kedalam Smartphone → 

Buka PDF Map → Pilih bukan dengan Avenza Map. 

 

7) Tampilan awal dalam Avenza pilih file PDF Map yang sudah 

dimasukkan kedalam aplikasi. 
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8) Setelah Map Terbuka, silakan melakukan Collecting Data. 
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9) Setelah selesai melakukan Collecting Data, Export file dengan 

format KML. 
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10) Kembali pada Arcgis, kemudian pilih Catalog->lalu pilih 

convert KML to Layer. 
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11) Selesai melakukan Collecting Data. 
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BAB 5 

PENGENALAN INTERNET OF THINGS (IOT) 

 

5.1. Tujuan 

a. Mengetahui dan Memahami Internet of Things. 

b. Mengetahui Integrasi Internet of Things dengan Sistem 

Informasi Geografis. 

c. Mengetahui dan Memahami Arduino IDE. 

d. Mengetahui dan Memahami Firebase. 

 

5.2. Pengenalan Internet of Things 

Internet of Things atau yang disingkat IOT adalah suatu konsep 

dimana objek tertentu yang mempunyai kemampuan untuk 

mentransfer data melalui jaringan internet tanpa memerlukan adanya 

interaksi dari manusia ke manusia ataupun dari manusia ke 

perangkat komputer. Internet of Things memiliki beberapa unsur 

pembentuk yaitu sebagai berikut: 

a. Kecerdasan Buatan (AI) 

Internet of Things membuat semua mesin yang tersedia menjadi 

mesin pintar, Dalam proses pengembangan teknologi dilakukan 

berbagai macam cara seperti pengumpulan data, artificial 

intelligence algorithm, dan jaringan yang tersedia. 

b. Konektivitas 

Konektivitas adalah sebuah penghubung dan pertukaran 

informasi yang terjadi pada Internet of Things. Dengan konektivitas 
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kita membuat atau membuka jaringan baru sehingga dapat 

terkoneksi dengan perangkat pintar.  

c. Sensor 

Sensor merupakan perangkat yang sangat canggih dimana alat ini 

bisa menangkap atau mendapatkan informasi terkait dari hal-hal 

tertentu seperti sensor gerak, suhu, udara, panas, dan lainnya 

d. Keterlibatan Aktif (Active Engangement) 

Engangement yang sering diterapkan teknologi umumnya yang 

termasuk pasif. Internet of Things ini mengenalkan paradigma yang 

baru bagi konten aktif, produk, maupun keterlibatan layanan. 

e. Perangkat berukuran kecil 

Perangkat seperti yang diperkirakan para pakar teknologi, 

memang menjadi semakin kecil, makin murah, dan lebih kuat dari 

masa ke masa. IoT memanfaatkan perangkat-perangkat kecil yang 

dibuat khusus ini agar menghasilkan ketepatan, skalabilitas, dan 

fleksibilitas yang baik. 

 

5.3. Cara Kerja Internet of Things 

 

Gambar 29. Konsep IoT 

(Sumber: https://mobnasesemka.com/internet-of-things/ dalam 

jurnal Efendi, 2018) 
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Cara kerja Internet of Things adalah dengan memanfaatkan 

instruksi pada suatu pemrograman, yang masing-masing perintahnya 

bisa menghasilkan interaksi antar perangkat yang telah saling 

terhubung. Cara kerja tersebut sifatnya otomatis dan tidak harus 

menggunakan campur tangan dari manusia.  

Internet bisa menjadi penghubung kedua interaksi pada suatu 

perangkat jarak jauh. Manusia hanya menjadi pengatur dan 

pengawas ketika alat tersebut sedang bekerja. Penyusunan jaringan 

komunikasinya yang terbilang cukup kompleks menjadi tantangan 

paling besar dalam Internet of Things, sehingga membutuhkan 

sistem keamanan yang cukup ketat. 

 

5.4. Integrasi Internet of Things dengan Sistem Informasi 

Geografis 

 

Gambar 30. Integrasi IoT 

(Sumber: Sulaiman dan Widarma, 2017) 
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Internet of Things dan Sistem Informasi Geografis dapat 

terintegrasi satu sama lain, dimana Internet of Things bertugas 

mengambil, menyimpan dan mengirimkan data. Sedangkan Sistem 

Informasi Geografis bertugas menampilkan data dan peta. Integrasi 

Internet of Things dan Sistem Informasi Geografis ini merupakan 

cara terbaik yang digunakan untuk membaca persebaran data secara 

real-time. Dimana dengan cepatnya arus informasi yang dihasilkan, 

maka pengambilan kebijakan dan analisis akan menjadi lebih cepat 

dan akurat.  

 

5.5. Perangkat Internet of Things dan Sistem Informasi 

Geografis 

a. NodeMCU V3 CH340 

 

Gambar 31. NodeMCU 

(Sumber: Khang & Pangaribuan, 2021) 

NodeMCU adalah sebuah platform Internet of Things yang 

bersifat open source. terdiri dari perangkat keras berupa system 

on chip ESP8266 dari ESP8266 buatan Espressif System, juga 

firmware yang digunakan, yang menggunakan bahasa 

pemrograman scripting Lua.  
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Istilah NodeMCU secara default sebenarnya mengacu pada 

firmware yang digunakan daripada perangkat keras development 

kit. NodeMCU bisa dianalogikan sebagai board arduino-nya 

ESP8266 

 

b. GPS Module UBLOX NEO-6M-V2 

 

Gambar 32. Ublox neo-6m GPS Receiver 

(Sumber: Firdaus & Ismail, 2020) 

GPS Module UBLOX NEO-6M-V2 berfungsi sebagai 

penerima Global Positioning System Receiver yang dapat 

mendeteksi lokasi dengan menangkap dan memproses sinyal dari 

satelit navigasi.  

Aplikasi dari modul ini melingkupi sistem navigasi, sistem 

keamanan terhadap perangkat bergerak, akuisisi data pada sistem 

pemetaan medan, penjejak lokasi atau location tracking, dan 

lainnya. 
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c. Sensor DHT11  

 

 

Gambar 33. DHT-11 

(Sumber: Fathulrohman & Saepuloh, 2018) 

Sensor DHT11 adalah module sensor yang berfungsi untuk 

mensensing objek suhu dan kelembaban yang memiliki output 

tegangan analog yang dapat diolah lebih lanjut menggunakan 

mikrokontroler. Module sensor ini tergolong kedalam elemen 

resistif seperti perangkat pengukur suhu seperti contohnya yaitu 

NTC. 

Sensor DHT11 pada umumya memiliki fitur kalibrasi nilai 

pembacaan suhu dan kelembaban yang cukup akurat. 

Penyimpanan data kalibrasi tersebut terdapat pada memori 

program OTP yang disebut juga dengan nama koefisien kalibrasi. 

Sensor ini memiliki 4 kaki pin, dan terdapat juga sensor DHT11 

dengan breakout PCB yang terdapat hanya memilik 3 kaki pin 

seperti gambar dibawah ini. 
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d. Kabel Jumper 

 

Gambar 34. Kabel Jumper 

(Sumber: Fathulrohman & Saepuloh, 2018) 

Kegunaan kabel jumper ini adalah sebagai konduktor listrik 

untuk menyambungkan rangkaian listrik. Biasanya kabel jumper 

digunakan pada breadboard atau alat prototyping lainnya agar 

lebih mudah untuk mengutak-atik rangkaian.  

Konektor yang ada pada ujung kabel terdiri atas dua jenis 

yaitu konektor jantan (male connector) dan konektor betina 

(female connector).  

 

5.6. Pengertian ARDUINO IDE 

Ardiuno Ide merupakan sebuah software yang digunakan 

untuk membuat, menulis program, memvalidasi dan juga 

mengupload program ke board ardiuno sesuai dengan keperluan 

projek yang akan dibangun.  

Arduino IDE menggunakan bahasa pemrograman C yang 

dimodifikasi. Bahasa pemrograman arduino sudah dirubah untuk 

memudahkan pemula dalam melakukan pemrograman dari bahasa 

aslinya.  
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Didalam arduino sendiri sudah terdapat IC mikrokontroler 

yang sudah ditanam program yang bernama Bootloader. Fungsi dari 

bootloader tersebut adalah untuk menjadi penengah antara compiler 

arduino dan mikrokontroler. Arduino IDE dibuat dari bahasa 

pemrograman JAVA yang dilengkapi dengan library C/C++ 

(wiring), yang membuat operasi input/output lebih mudah. 

 

5.7. Pengenalan Tampilan Ardiuno IDE 

a. Tampilan Ardiuno Ide 
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b. Tampilan Menu File 

 

Keterangan:  

1. Sketchbook, berfungsi untuk menampilkan Sketch 

yang sudah tersimpan di dalam folder  

2. Example, berisi berbagai contoh kode program yang 

disediakan oleh pengembang.  

3. Close, berfungsi menutup jendela Arduino IDE 

sekaligus menghentikan Aplikasi.  

4. Page Setup, berfungsi mengatur tampilan page 

seperti paper, orientation, margins untuk pencetakan 

Sketch.  

5. Print, berfungsi mengirimkan file Sketch ke mesin 

cetak untuk dicetak atau di buatkan menjadi file pdf.  

6. Preferences, berfungsi merubah tampilan interface 

Arduino IDE.  

7. Quit, berfungsi untuk menutup semua jendela 

Arduino IDE. Sketch yang masih terbuka pada saat 
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tombol Quit ditekan, secara otomatis akan terbuka 

pada saat Arduino IDE dijalankan. 

c. Tampilan Menu Edit 

 

Keterangan:  

1. Copy for Forum, berfungsi melakukan copy kode dari 

editor dan melakukan formating agar sesuai untuk 

ditampilkan dalam forum.  

2. Copy as HTML, berfungsi menduplikasi teks yang 

terpilih kedalam editor dan menempatkan teks 

tersebut pada clipboard dalam bentuk atau format 

HTML. 

3. Comment/Uncomment, berfungsi untuk menggubah 

teks atau kode yang sudah terpilih menjadi berstatus 

“komen” yang di tandakan muncul tanda //  

4. Increase Indent, berfungsi untuk menambahkan 

Indentasi pada baris tertentu.  



136 
 

5. Decrease Indent, berfungsi untuk mengurangi 

Indentasi pada baris tertentu 

d. Tampilan Menu Sketch 

 

Keterangan:  

1. Verify/Compile, berfungsi untuk mengecek Sketch 

yang kamu buat apa ada kekeliruan dalam segi bahasa 

programnya (error). jika tidak ada, program yang 

kamu buat akan di compile.  

2. Upload, berfungsi mengirimkan program yang sudah 

compile ke Arduino Board.  

3. Upload Using Programmer, berfungsi untuk 

menuliskan bootloader kedalam IC Mikrokontroler 

Arduino. Pada kasus ini kamu membutuhkan 

perangkat tambahan seperti USBAsp untuk 

menjembatani penulisan program bootloader ke IC 

Mikrokontroler.  

4. Export Compiled Binary, berfungsi untuk 

menyimpan file dengan ekstensi .hex, yang nantinya 

file ini dapat di upload ke board lain dengan aplikasi 

yang berbeda.  
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5. Show Sketch Folder, berfungsi membuka lokasi 

folder Sketch yang saat ini sedang dikerjakan.  

6. Include Library, berfungsi untuk menambahkan 

library/pustaka yang sudah di sediakan pengembang 

ke dalam Sketch yang sedang di kerjakan.  

7. Add File, berfungsi untuk menambahkan file 

kedalam Sketch Arduino, File akan muncul sebagai 

tab baru dalam jendela Sketch. 

e. Tampilan Menu Tools 

 

Keterangan:  

1. Auto Format, berfungsi melakukan pengaturan 

format kode pada jendela Sketch.  

2. Archive Sketch, berfungsi menyimpan Sketch 

kedalam file .zip  

3. Fix Encoding & Reload, berfungsi memperbaiki 

kemungkinan perbedaan antara pengkodean karakter 

Sketch dan peta karakter sistem operasi yang lain.  
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4. Manage Libraries, Berfungsi untuk menginstall 

library tambahan dari Arduino team, atau 

pengembang pihak ke-tiga yang sudah mendaftarkan 

librarynya di Arduino.  

5. Serial Monitor, berungsi membuka jendela serial 

monitor untuk melihat pertukaran data interface 

komunikasi serial dari program yang telah di buat.  

6. Serial plotter, berfungsi untuk menanampikan 

gelombang sinus  

7. Wifi101 / wfiNINA firmware updater, Berfungsi 

untuk mengupdate wifi101/ wifiNINA  

8. Board, berfungsi memilih dan melakukan konfigurasi 

board yang ingin digunakan.  

9. Port, berfungsi untuk menyesuaikan port sebagai 

jalur komunikasi antara software dengan hardware.  

10. Programmer, menu ini digunakan ketika kamu 

hendak melakukan pemrograman chip 

mikrokontroller tanpa menggunakan koneksi 

Onboard USB-Serial. Biasanya digunakan pada 

proses burning bootloader.  

11. Burn Bootloader, mengizinkan kamu untuk 

mengkopikan program bootloader kedalam IC 

mikrokontroler.  
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f. Tampilan Shortcut Pemrograman 

 

Keterangan:  

1. Verify: berfungsi untuk mengecheck program yang 

sudah kita buat sudah sesuai dengan kaidah tata cara 

penulisan bahasa C++ for Arduino atau belum.   

2. Upload: berfungsi untuk mengirimkan program yang 

sudah kita buat dari software Arduino IDE ke 

memory board Arduino.   

3. New Sketch: berfungsi untuk Membuka lembar kerja 

baru atau Sketch.  

4. Open:  berfungsi untuk membuka lembar kerja atau 

Sketch yang sudah pernah di buat untuk melakukan 

pengeditan atau pun untuk upload ulang.  

5. Save: berfungsi untuk menyimpan Sketch yang telah 

di buat ke dalam media penyimpanan kita.  

6. Serial monitor: berfungsi untuk melihat data interface 

komunikasi serial dari program yang telah kita buat, 

yang dikirimkan atau dipertukarkan antara Arduino 

dengan Sketch pada port serialnya. Serial monitor ini 

dapat digunakan untuk menampilkan nilai proses, 

nilai pembacaan, bahkan pesan error terdapat pada 

program yang telah kita buat.  
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5.8. Pengertian Firebase 

 

Firebase merupakan salah satu layanan dari Google yang 

memudahkan para-app developer dalam mengembangkan aplikasi 

mereka. Firebase termasuk ke dalam kategori BaaS (Backend-as-a-

Service). 

Singkat cerita mengenai sejarah dari Firebase pertama kali 

didirikan oleh Andrew Lee dan James Tamplin pada tahun 2011. 

Produk pertama kali yang dikembangkan oleh mereka adalah 

Realtime database. Kemudian sekarang sudah berkembang menjadi 

layanan penyedia pengembangan aplikasi. Pada Oktober 2014, 

perusahaan tersebut diakusisi oleh Pihak Google, sampai saat ini 

firebase dikelola oleh Google sampai saat ini masih terus 

mengembangkan layan Firebase tersebut. Hingga pada Mei 2016 

Firebase diperkenalkan di Google I/O. 

Mengenai segi layanan, dulu Firebase memberikan service 

trial (percobaan), namun saat ini kamu bisa memanfaatkan dan 

menggunakan layanan Firebase secara free (gratis). Tentu saja 

dengan adanya batasan-batasan tertentu. 
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Layanan-layanan yang tersedia dari Firebase ada 2 pilihan, di 

antaranya: 

a. SPARK: kita bisa menggunakan layanan secara gratis. 

b. BLAZE: kita akan dikenakan biaya sesuai dengan 

pemakaian layanan. 

 

Berikut ini beberapa layanan yang ada di Firebase adalah sebagai 

berikut:  

a. Firebase Analytics 

Analytics menyajikan data seputar perilaku pengguna pada 

aplikasi Android dan iOS agar Anda dapat mengambil keputusan 

yang lebih baik tentang produk dan pengoptimalan pemasaran. Lihat 

data error, efektivitas notification, performa deep link, data 

pembelian dalam aplikasi, dan lain-lain. 

b. Firebase Cloud Messaging and Notifications 

FCM (Firebase Cloud Messaging) yaitu menyediakan koneksi 

yang handal dan tentunya hemat baterai antar server maupun 

antar device. Sehingga kamu dapat mengirim dan menerima pesan 

serta notifikasi di Android, iOS, dan web tanpa perlu biaya. Pesan 

notifikasi ini terintegrasi sepenuhnya dengan Google Analytics for 

Firebase, sehingga kamu memiliki akses pada interaksi dan tracking 

konversi secara detaill. Nah, Anda dapat memantau suatu efektivitas 

dari satu dashboard tanpa perlu coding atau membuat program 

sendiri. 
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c. Firebase Authentication 

Firebase Authentication adalah salah satu layanan back-

end, fitur Android dan iOS, SDK yang mudah digunakan, dan 

tampilan interfaces yang siap pakai untuk mengautentikasi 

pengguna ke aplikasi yang dibuat. Firebase Authentication 

mendukung autentikasi menggunakan nomor telepon, sandi, 

penyedia identitas gabungan populer seperti Google, Facebook, dan 

sebagainya. 

Firebase Authentication terintegrasi dengan fitur layanan 

Firebase lainnya. Sistem ini memanfaatkan berbagai jenis standar 

industri, seperti OAuth 2.0 dan OpenID Connect, yang memudahkan 

integrasi dengan backend khusus buatanmu. 

d. Firebase Cloud Firestore 

Cloud Firestore merupakan database NoSQL yang bersifat 

fleksibel dan terukur untuk pengembangan perangkat seperti seluler, 

web, dan server di Firebase dan Google Cloud Platform. Cloud 

Firestore membuat datamu tetap terkoneksi di aplikasi user melalui 

listener realtime dan menawarkan layanan secara offline untuk 

aplikasi seluler dan web. Dengan begitu, kamu dapat membuat 

aplikasi yang powerfull, responsif, dan mampu bekerja tanpa 

bergantung pada latensi koneksi internet. 

e. Firebase Realtime Database 

Firebase Realtime Database adalah database yang di-host 

melalui cloud. Data disimpan dan dieksekusi dalam 

bentuk JSON dan disinkronkan secara realtime ke setiap user yang 

terkoneksi. Ketika kamu membuat aplikasi lintas-
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platform/multiplatform menggunakan SDK Android, iOS, dan juga 

JS (JavaScript), semua pengguna akan berbagi sebuah 

instance Realtime Database dan menerima update-an data secara 

serentak dan otomatis. 

f. Firebase Hosting 

Firebase Hosting, suatu layanan hosting konten web. Hanya 

dengan satu instruksi, kamu dapat mengimplementasikan aplikasi 

web serta menyajikan konten statis maupun dinamis ke 

CDN  (jaringan penayangan konten) global dengan cepat. Kegunaan 

dari Firebase Hosting itu sendiri yaitu mampu menayangkan konten 

melalui koneksi yang begitu aman, mengirimkan konten secara 

cepat, dan mendukung semua jenis konten untuk di hosting, mulai 

dari file HTML dan CSS  hingga API atau layanan mikro Express.js..  

 

5.9. Intalasi Arduino IDE 

1) Persiapkan File Installer Arduino IDE, jika yang belum memiliki 

bisa mendownload terlebih dahulu pada: 

https://www.arduino.cc/en/software. 

2) Buka File Installer Arduino IDE, akan muncul tampilan seperti 

dibawah: 
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3) Pilih, I Agree. 

 

 

 

 

 



145 
 

4) Ceklis semua pada Components to Instal. 

 

5) Silakan atur dengan browse Destination Folder untuk 

menyimpan file-file Arduino, lalu Klik Install jika sudah 

menentukan Destination Folder. 

 

6) Tunggu proses instalasi hingga selesai, Klik Close untuk 

mengakhiri Installasi. 
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7) Installasi Arduino IDE telah selesai dan siap untuk digunakan. 
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5.10. Membuat Project Firebase 

8) Silakan buka browser yang ada pada device, lalu arahkan url 

kehalaman: https://firebase.google.com/. 

9) Pastikan kamu login dengan gmail yang ingin dibuat project. 

 

10) Klik Buka Console (Buka konsol yang ada di pojok kanan atas 

halaman). 

 

11) Selanjutnya kita akan membuat project di firebase, caranya klik 

Create a Project. 

 

12) Masukan Nama Project dan jika sudah terisi nama project celist 

pada I accept the Firebase terms (telah memahami segala 

ketentuan yang berlaku pada firebase), Lalu Klik Continues. 
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13) Silakan tidak ceklist pada menu aktifkan google analytics untuk 

project ini. Artinya disini kita tidak menggunakan google 

analytics. Lalu klik klik create project. 

 

14) Tunggu proses pembuatan projectnya selesai, lalu Continues. 
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15) Lalu Klik Build pada menu dashboard, lalu klik Realtime 

Database. Kita akan membuat database yang realtime. 

 

16) Selanjutnya kita akan membuat database. Klik Create 

Database. 

 

17) Silakan pilih Pengaturan lokasi Anda adalah tempat 

penyimpanan data Realtime Database Anda (default: United 

States (us-central1)). 
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18) Pilih Mulai dalam locked mode. 

 

19) Lalu klik Rules atau Aturan, lalu ubah read, write menjadi true 

dan setelah dirubah Publikasi atau Publish selesai untuk 

pembuatan Realtime Database. Selanjutnya membuat agar data 

Realtime Database dapat diakses melalui berbagai platfrom. 
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20) Klik lambang gear disamping tulisan Project Overview. 

Lalu klik Project settings.

 

21) Lalu scroll kebawah terdapat Your apps, klik tombol web app 

(</>). 
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22) Masukan Nama aplikasi, klik Register app 

 

23) Terdapat script untuk menampilkan sebuah data-data dari sebuah 

Data Realtime Firebase yang sudah pernah dibuah sebelumnnya. 
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24) Jika lupa scriptnya bisa dapat melihat kembali pada Project 

settings yang terdapat pada gear disamping Project Overview, 

lalu klik Project Settings dibagian bawah yang sebelumnya Your 

App. 

 

25) Jika ingin mengabungkan alat dengan dengan firebase Data 

Realtime yang sudah pernah kita buat biasanya memerlukan 

sebuah Firebase auth untuk mengirim data. Firebase auth 

terdapat pada pada gear disamping Project Overview lalu klik 

Project Settings, kemudian klik menu Service Account dan klik 

Database Secrets. 

26) Selesai. 
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BAB 6 

INPUT DATA BERBASIS IOT 

 

6.1. Tujuan 

a. Mampu memahami jenis-jenis sensor. 

b. Memahami suhu dan kelembaban. 

c. Mampu menginstall package pada Ardiuno IDE. 

d. Mampu merakit Alat IOT Monitoring Suhu, Kelembaban 

dan koordinat wilayah tertentu. 

e. Mampu membuat Program IoT Monitoring Suhu, 

Kelembaban dan koordinat wilayah tertentu serta 

menyimpan datanya di Firebase. 

 

6.2. Jenis-Jenis Sensor 

Sensor adalah perangkat yang digunakan untuk mendeteksi 

perubahan besaran fisik seperti tekanan, gaya, besaran listrik, 

cahaya, gerakan, kelembaban, suhu, kecepatan dan fenomena-

fenomena lingkungan lainnya. Setelah mengamati terjadinya 

perubahan, Input yang terdeteksi tersebut akan dikonversi mejadi 

Output yang dapat dimengerti oleh manusia baik melalui perangkat 

sensor itu sendiri ataupun ditransmisikan secara elektronik melalui 

jaringan untuk ditampilkan atau diolah menjadi informasi yang 

bermanfaat bagi penggunanya.  

Sensor pada dasarnya dapat digolong sebagai Transduser 

Input karena dapat mengubah energi fisik seperti cahaya, tekanan, 

gerakan, suhu atau energi fisik lainnya menjadi sinyal listrik ataupun 
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resistansi (yang kemudian dikonversikan lagi ke tegangan atau 

sinyal listrik).   

Adapun beberapa jenis–jenis sensor berdasarkan 

penggunaanya adalah sebagai berikut: 

1) Sensor Cahaya (Light Sensor)  

Sensor Cahaya adalah Sensor analog yang digunakan untuk 

mendeteksi jumlah cahaya  yang mengenai Sensor tersebut. Sensor 

cahaya analog ini dapat diklasifikasikan lagi  menjadi beberapa jenis 

seperti foto-resistor, Cadmium Sulfide (CdS), dan fotosel. Light  

dependent resistor atau LDR dapat digunakan sebagai sensor cahaya 

analog yang dapat  digunakan untuk menghidupkan dan mematikan 

beban secara otomatis berdasarkan  intensitas cahaya yang 

diterimanya. Resistansi LDR akan meningkat apabila intensitas  

cahaya menurun. Sebaliknya, Resistansi LDT akan menurun apabila 

intensitas cahaya  yang diterimanya bertambah.  

 

2) Sensor Ultrasonik (Ultrasonic Sensor)  

 

Gambar 35. Sensor Ultrasonik 

(Sumber: Puspasari et al, 2019) 
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Sensor Ultrasonik adalah jenis sensor non-kontak yang dapat 

digunakan untuk  mengukur jarak serta kecepatan suatu benda. 

Sensor Ultrasonik bekerja berdasarkan  sifat-sifat gelombang suara 

dengan frekuensi lebih besar daripada rentang suara  manusia. 

Dengan menggunakan gelombang suara, Sensor Ultrasonik dapat 

mengukur  jarak suatu objek (mirip dengan SONAR). Sifat Doppler 

dari gelombang suara dapat  digunakan untuk mengukur kecepatan 

suatu objek.  

 

3) Sensor Suhu (Temperature Sensor)  

Sensor Suhu adalah Sensor tersedia secara luas baik dalam bentuk 

sensor digital  maupun analog. Ada berbagai jenis sensor suhu yang 

digunakan untuk aplikasi yang  berbeda. Salah satu Sensor Suhu 

adalah Termistor, yaitu resistor peka termal yang  digunakan untuk 

mendeteksi perubahan suhu. Apabila Suhu meningkat, resistansi  

listrik dari termistor akan meningkat juga. Sebaliknya, jika suhu 

menurun, maka  resistansi juga akan menurun. 

 

4) Sensor Kelembaban (Humidity Sensor)  

Sensor Kelembaban merupakan sensor yang digunakan untuk 

mendeteksi tingkat  kelembaban suatu lokasi. Pengukuran Tingkat 

Kelembaban ini sangat penting untuk  pengamatan lingkungan di 

suatu wilayah, diagnosa medis ataupun di penyimpanan  produk-

produk yang sensitif.  
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Gambar 36. Sensor Kelembaban Tanah 

(Sumber: Mardika & Kartadie, 2019) 

 

5) Sensor Tekanan (Pressure Sensor)  

Sensor Tekanan adalah Sensor yang digunakan untuk mengukur 

jumlah tekanan yang  diterapkan pada sebuah sensor. Sensor tekanan 

akan menghasilkan sinyal keluaran  analog yang sebanding dengan 

jumlah tekanan yang diberikan. Sensor piezoelektrik  adalah salah 

satu jenis sensor tekanan yang dapat menghasilkan sinyal tegangan  

keluaran yang sebanding dengan tekanan yang diterapkan padanya.  

 

6.3. Sensor DHT11 

Sensor DHT11 adalah salah satu jenis sensor yang banyak 

digunakan pada project  berbasis Arduino. Sensor ini memiliki 

keunikan yaitu dapat membaca suhu (temperature)  ruangan dan 

kelembaban udara (humidity). Sensor DHT11 merupakan 

serangkaian komponen  senor dan IC kontroller yang dikemas dalam 

satu paket. Sensor ini ada yang memiliki 4 pin  ada pula yang 3 pin. 

Tapi tidak menjadi masalah karena dalam penerapannya tiak ada  

perbedaan. Didalam bodi sensor yang berwarna biru atau putih 
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terdapat sebuah Resistor dengan  tipe NTC (Negative Temperature 

Coefficient). Resistor jenis ini memiliki karakteristik dimana  nilai 

resistansinya berbanding terbalik dengan kenaikan suhu. Artinya, 

semakin tinggi suhu  ruangan maka nilai resistansi NTC akan 

semakin kecil. Sebaliknya nilai resistansi akan  meningkat ketika 

suhu disekitar sensor menurun. Selain itu didalamnya terdapat 

sebuah sensor  kelembapan dengan karkteristik resistif terhadp 

perubahan kadar air di udara. Data dari kedua  sensor ini diolah 

didalam IC kontroller. IC kontroller ini akan mengeluarkan output 

data dalam  bentuk single wire bi-directional. 

 

6.4. Modul GPS Unblox neo – 6m 

Modul GPS Unblox neo – 6m berfungsi untuk mengetahui 

lokasi suatu tempat atau  koordinat dimana modul GPS itu berada, 

sehingga dengan modul tersebut kita dapat membuat berbagi macam 

alat yang memerlukan lokasi atau titik koordinat. dari modul tersebut 

kita dapat  mendapatkan titik garis lintang atau latitude dan garis 

bujur atau longitude.  

Cara Kerja GPS Module: Pastikan GPS kamu sudah dapat 

sinyal, cirinya adalah akan ada led kecil yang berkedip. Jika ternyata 

led nya tidak berkedip terus, kamu coba pindah ruangan  atau jika 

masih tidak bisa kamu bisa mencobanya langsung diluar. Karena 

GPS ini aksesnya  langsung ke satelite. 
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6.5. Suhu 

Suhu menunjukkan derajat panas benda. Mudahnya, semakin 

tinggi suhu suatu benda,  semakin panas benda tersebut. Secara 

mikroskopis, suhu menunjukkan energi yang dimiliki  oleh suatu 

benda. Setiap atom dalam suatu benda masing-masing bergerak, baik 

itu dalam  bentuk perpindahan maupun gerakan di tempat getaran. 

Makin tingginya energi atom-atom  penyusun benda, makin tinggi 

suhu benda tersebut.  

 

6.6. Kelembaban Udara 

Kelembaban adalah konsentrasi uap air di udara. Angka 

konsentrasi ini dapat  diekspresikan dalam kelembaban absolut, 

kelembaban spesifik atau kelembaban relatif. Alat  untuk mengukur 

kelembaban disebut higrometer. Sebuah humidistat digunakan untuk  

mengatur tingkat kelembaban udara dalam sebuah bangunan dengan 

sebuah pengawalembab (dehumidifier). Dapat dianalogikan dengan 

sebuah termometer dan termostat untuk suhu udara.  Perubahan 

tekanan sebagian uap air di udara berhubungan dengan perubahan 

suhu. Konsentrasi air di udara pada tingkat permukaan laut dapat 

mencapai 3% pada 30 °C (86 °F), dan tidak  melebihi 0,5% pada 0 

°C (32 °F). Banyaknya uap air mempengaruhi tingkat kelembaban 

di  udara. Di negara-negara tropis seperti di Indonesia, tingkat 

kelembaban pada umumnya relatif  tinggi, dengan suhu yang relatif 

konstan, tingkat kelembaban tidak banyak mengalami  perubahan 

sepanjang tahun. Perubahan drastis biasanya terjadi pada saat 

memasuki musim  hujan dan musim kemarau.  



160 
 

Berbeda dengan di luar ruangan (outdoor), tingkat 

kelembaban di dalam ruangan lebih  mudah berubah, tergantung dari 

aktivitas yang dilakukan. Sebagai contoh, kegiatan mandi dan  

mencuci akan membuat tingkat kelembaban di dalam ruangan 

menjadi tinggi. Sementara  kegiatan lain yang tidak menggunakan 

air dan dilakukan di ruangan ber-AC akan membuat  ruangan 

menjadi kering karena sifat dari udara dingin yang hanya dapat 

menampung sedikit  uap air. Idealnya, kelembaban udara harus 

dijaga dalam kisaran 45%-64% (RH). Secara umum  ada beberapa 

indikator, yaitu dari yang tampak oleh mata (jamur pada tembok, cat 

tembok yang  mengelupas), dari yang terasa oleh kulit (kulit 

berkeringat atau kering bersisik), dan yang  paling akurat adalah 

dengan bantuan alat pengukur tingkat kelembaban, yaitu 

hygrometer.  

Para ahli kesehatan merekomendasikan tingkat kelembaban 

udara (atau yang disebut  dengan Relative Humidity -- RH) pada 

kisaran 45% - 65%, sebagai tingkat yang ideal. Bila  kelembaban 

udara di dalam ruangan di atas 65% (RH), maka virus, jamur, 

tungau, lumut, dan  bakteri yang menjadi pemicu alergi bagi 

penderita asma akan bertumbuh dengan pesat.  Serangga dan kecoa 

juga dapat berkembang biak lebih pesat di tempat yang lembab.  

Sebaliknya, jika kelembaban di bawah 45% (RH), maka kulit, 

tenggorokan, mata menjadi  kering dan gatal, saluran udara dan 

membran mukosa yang berfungsi sebagai pembatas natural  terhadap 

penyakit juga menjadi kering sehingga tubuh kita lebih rentan 

terhadap penyakit.  Selain itu, di tempat yang kelebaban rendah, 
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virus influenza dapat bertahan hidup lebih lama. Bila tingkat 

kelembaban cenderung tinggi atau berada di atas 65% (RH), maka 

diperlukan  dehumidifier (penyerap udara lembab) untuk 

mengembalikan tingkat kelembaban ke tingkat  ideal. Sebaliknya, 

bila hasilnya cenderung rendah atau di bawah 45% (RH) maka 

dibutuhkan  humidifier (pelembab udara).  

 

6.7. Merakit Alat IoT Monitoring Suhu, Kelembebaban dan 

Kooridnat 

A. Alat dan bahan 

1) NodeMCU 8266 V2/V3. 

2) Breadboard. 

3) DHT-11. 

4) GPS Module Neo-6M. 

5) Jumper Male to Male. 

6) Header Male. 

7) Baterai 9 Volt. 

8) Socket Baterai. 

9) Kabel Micro USB. 

10) Projectboard.  
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B. Metode kerja 

1)  Siapkan alat dan bahan yang akan digunakan. 

2) Pasang NodeMCU pada breadboard. 

3) Pasang DHT11 pada Breadboard. 

4) Pasang GPS module yang sudah dipasang atau ditambahkan 

header male pada  Breadboard. 

5) Pertama silakan hubungkan NodeMCU dengan DHT11 pada 

breadboard  menggunakan jumper male to male. Untuk 

susunannya seperti table berikut ini:  

DHT11 NodeMCU 8266 

VCC 3V 

GND GND 

Data/output D1 

6) Silakan hubungkan NodeMCU dengan GPS Module pada 

breadboard menggunakan jumper male to male. Untuk 

susunannya seperti table berikut ini: 

GPS Module Neo 6M NodeMCU 8266 

VCC 3V 

GND GND 

 

RX  D3 
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TX  D2 

7) Setelah semuanya dihubungkan, selanjutnya kita akan 

menghubungkan  NodeMCU ke komputer dengan menggunakan 

MicroUSB untuk diprogram Note: Apabila ingin menggunakan 

Baterai silakan hubungkan kutub positif  battery 9V ke kaki Vin 

(NodeMCU 8266) dan kutub negatif battery 9V ke kaki  GND 

(NodeMCU 8266). Berikut Kapasitas baterai 9 Volt. 

 

8) Alat berhasil kita rakit. Selanjutnya kita kan melakukan 

pemrograman pada  alatnya. Sebelum kita membuat program 

untuk alatnya diperlukan beberapa driver dan library yang  harus 

kita masukan atau tambahkan.  
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6.8. Menambahkan Board dan Menginstall Drive NodeMCU 

A. Alat dan bahan 

1) Ardiuno IDE. 

2) Driver NodeMCU CH341SER (untuk NodeMCU V3). 

http://www.wch-ic.com/downloads/CH341SER_EXE.html 

3) Driver NodeMCU CP210x (untuk NodeMCU V2). 

https://www.silabs.com/developers/usb-to-uart-bridge-vcp-

drivers  

 

B. Metode kerja 

Dikarenakan pada kali ini kita tidak menggunakan board 

Ardiuno, maka kita perlu menambahkan esp8266. Caranya sebagai 

berikut:  

1) Silakan buka software Ardiuno IDE. 

2) Klik File → Preferences. 

 

3) Pada Additional Board Manager URLs: isi dengan url 

berikut:  
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http://arduino.esp8266.com/stable/package_esp8266c

om_index.json 

4) Lalu Klik OK  

 

5) Selanjutnya Buka Board Manager dengan cara klik Tools → 

Board Manager. 

 

6) Tunggu Loadingnya sampai selesai. Lalu pada kolom pencarian 

ketik ESP8266, Pilih yang esp8266 by esp8266 Community. 
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Pilih versi yang 2.7.4 → lalu klik Install. 

 

7) Instalasi selesai dilakukan apabila ada tulisan Installed. 

Apabila sudah selesai, silakan klik Close. 

 

8) Lalu klik Tools → Board → ESP8266 Boards (2.5.2) → 

NodeMCU 1.0 (ESP 12E Module). 
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9) Selanjutnya kita cek apakah boardnya sudah NodeMCU 1.0 

(ESP-12E Module).  Apabila Board:” NodeMCU 1.0 (ESP-

12E Module)”. Artinya boardnya sudah NodeMCU. 

10) Board ESP8266 berhasil ditambahkan. 

 

6.9. Menginstal Driver NodeMCU CH340 (NodeMCU V3) 

A. Alat dan bahan 

1) Driver NodeMCU CH341SER  

 

B. Metode kerja 

1) Download driver NodeMCU CH341SER 

http://www.wch-ic.com/downloads/CH341SER_EXE.html  

2) Silakan buka driver NodeMCU CH341SER. 

3) Double Klik Setup.exe. 
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4) Lalu klik Install. 

 

5) Lalu klik OK 
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6) Selanjutnya kita cek apakah Driver berhasil diinstal. 

7) Selanjutnya masuk ke Device Manager dengan cara klik Start 

lalu ketikan pada windows search Device Manager. Lalu double 

Klik Device Manager. 

 

8) Saat kondisi NodeMCU terhubung dengan komputer, perhatikan 

pada bagian port, pastikan perangkat terdeteksi (dan ingat-ingat 

nama comnya, pada kasus saya terdeteksi sebagai USB – 

SERIAL CH340(COM4). 
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6.10. Menginstal Driver NodeMCU CP210x (NodeMCU V2) 

A. Alat dan bahan 

11) Driver NodeMCU CP210x. 

 

B. Metode kerja 

1) Download Driver NodeMCU CP210x 

2) https://www.silabs.com/developers/usb-to-uart-bridge-vcp-

drivers. 

3) Silakan buka file driver NodeMCU CP210x.  

4) Pilih sesuai speksifikasi laptop. Disini saya pilih 

CP210xVCPInstaller_x64.  

5) Silakan double klik CP210xVCPInstaller_x64.exe 
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6) Lalu klik Next. 

 
7) Lalu klik Finish. 
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6.11. Memasukan Liblary pada Arduino IDE 

Memasukan Library DHT11 ke Arduino IDE: 

A. Alat dan bahan 

1) Arduino IDE. 

 

B. Metode kerja 

1) Buka Software Arduino IDE.  

2) Pilih menu Sketch → include library → Manage Library. 
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3) Tunggu loading selesai Lalu pada kolom pencarian ketik 

DHT11. Pilih DHT11 by Adafruit. 

 
4) Silakan pilih Install dan select versionya yang 1.4.0. Apabila 

proses install selesai nanti akan muncul tulisan Installed seperti 

gambar diatas. 
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5) Library DHT11 berhasil ditambahkan. Silakan klik Close. 

 

Memasukan Library ArduinoJson ke Ardiuno IDE: 

A. Alat dan bahan 

1) Arduino IDE. 

 

B. Metode kerja 

1) Buka Software Arduino IDE. 

2) Pilih menu Sketch → include library → Manage Library. 

3) Lalu pada kolom pencarian ketik “ArduinoJson”. 

 

4) Install dan select versionya yang 6.18.5. Apabila proses install 

selesai nanti akan muncul tulisan Installed seperti gambar diatas. 

5) Library ArduinoJson berhasil ditambahkan. Silakan klik Close.  

 

Memasukan Library NTPClient ke Arduino IDE: 

A. Alat dan bahan 

1) Arduino IDE. 

 

B. Metode kerja 

1) Buka Software Arduino IDE. 

2) Pilih menu Sketch → include library → Manage Library. 

3) Lalu pada kolom pencarian ketik “NTPClient”. 
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4) Install dan select versionya yang 3.2.0. Apabila proses install 

selesai nanti akan muncul tulisan Installed seperti gambar 

diatas. 

5) Library ArduinoJson berhasil ditambahkan. Silakan klik Close.  

 

Memasukan Library TinyGPS ++ ke Arduino IDE: 

A. Alat dan bahan 

1) Arduino IDE. 

2) TinyGPSPlus-1.0.2b.zib. 

 

B. Metode kerja 

1) Download Library TinyGPS++. 

2) https://github.com/mikalhart/TinyGPSPlus/releases. 

3) Silakan siapkan file TinyGPSPlus-1.0.2b.zip yang sudah 

didownload yaitu versi 1.0.2b, klik Source code (.zip) 

 

4) Buka software Arduino IDE. 

5) Lalu klik Sketch → Include Library → add .zip Library. 
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6) Silakan pilih file TinyGPSPlus-1.0.2b.zip → OPEN. 

 

7) Library TinyGPS sudah berhasil ditambahkan. 
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Memasukan Library Firebase ke Arduino IDE: 

A. Alat dan bahan 

1) Arduino IDE. 

2) Firebase-arduino-master.zip. 

 

B. Metode kerja 

1) Download Library Firebase. 

https://github.com/FirebaseExtended/firebase-arduino. 

Silakan siapkan file Firebase-arduino-master.zip yang sudah 

didownload. 

2) Buka software Arduino IDE. 

3) Lalu klik Sketch → Include Library → add .zip Library 

 

4) Silakan pilih file Firebase-arduino-master.zip → OPEN. 
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5) Library Firebase sudah berhasil ditambahkan. 

 

6.12. Membuat Program IoT 

A. Alat dan bahan 

1) Software Arduino Ide  

2) Alat yang sudah dirakit  

3) MicroUSB. 

 

B. Metode kerja 

1) Langkah pertama silakan buka Arduino IDEnya. 

2) Silakan buat New File. Klik File → New. 

3) Hubungkan Alat IOT ke komputer menggunakan kabel 

MicroUSB. 

4) Selanjutnya cek Device Manager. Klik Start ketikan device 

manager. Lalu klik Device manager dan enter. 
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5) Saat kondisi NodeMCU terhubung dengan komputer, perhatikan 

pada bagian port, pastikan perangkat terdeteksi (dan ingat-ingat 

nama comnya, pada kasus saya terdeteksi sebagai USB – 

SERIAL CH340(COM4) 
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6) Apabila boardnya sudah kita atur. Selanjutnya kita atur Portnya. 

Klik Tools → Ports → COM4. Note: COM4 sesuai dengan 

keterangan PORT pada device manager. 
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7) Selanjutnya Proses Membuat Program. Silakan masukan kode 

program berikut ini. 

//GPS 

#include <TinyGPS++.h> 

#include <SoftwareSerial.h> 

int RXPin = D2; 

int TXPin = D3; 

SoftwareSerial gpsSerial(RXPin, TXPin); 

TinyGPSPlus gps; 

float latitude, longitude; 

String lat_str, lng_str; 
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//WIFI 

#include <ESP8266WiFi.h> 

#define WIFI_SSID "DESKTOP-6IDBF47" 

#define WIFI_PASSWORD "12345678" 

 

//FIREBASE 

#include <FirebaseArduino.h> 

#define FIREBASE_HOST "gisiot-default-

rtdb.firebaseio.com" 

#define FIREBASE_AUTH 

"o1sAR4U9cId9QRnF3vdCctICQhs8AVQQr5bS0Pew" 

 

//DHT11 

#include "DHT.h" 

#define DHTPIN D1 

#define DHTTYPE DHT11 

DHT dht(DHTPIN, DHTTYPE); 

int suhu, kelembaban; 

 

//TIME 

#include <NTPClient.h> 

#include <WiFiUdp.h> 

WiFiUDP ntpUDP; 

NTPClient timeClient(ntpUDP, "pool.ntp.org", 25200); 

String nama_hari[7] = {"Minggu", "Senin", "Selasa", 

"Rabu", "Kamis", "Jum'at", "Sabtu"}; 
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String nama_bulan[12] = {"Januari", "Februari", "Maret", 

"April", "Mei", "Juni", "Juli", "Agustus", "September", 

"Oktober", "November", "Desember"}; 

 

void setup() { 

  Serial.begin(9600); 

 

  //DHT11 

  dht.begin(9600); 

  //sensor 

  gpsSerial.begin(9600); 

 

  //WiFi 

  WiFi.begin(WIFI_SSID, WIFI_PASSWORD); 

  Serial.print("Sedang Mengubungkan"); 

  while (WiFi.status() != WL_CONNECTED) { 

    Serial.print("."); 

    delay(500); 

  } 

  Serial.println(); 

  Serial.print("Terhubung dengan Jaringan "); 

  Serial.println(WiFi.localIP()); 

 

  //Firebase 

  Firebase.begin(FIREBASE_HOST, FIREBASE_AUTH); 

} 
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void loop() 

{ 

  float kelembaban = dht.readHumidity(); 

  float suhu = dht.readTemperature(); 

  timeClient.update(); 

 

  unsigned long waktu_epoch = timeClient.getEpochTime(); 

  String jam = timeClient.getFormattedTime(); 

  String hari = nama_hari[timeClient.getDay()]; 

  struct tm *ptm = gmtime ((time_t *)&waktu_epoch); 

  int tanggal = ptm->tm_mday; 

  String bulan = nama_bulan[ptm->tm_mon];; 

  int tahun = ptm->tm_year + 1900; 

  String waktu_terkini = hari + ", " + String(tanggal) + " " + 

bulan + " " + String(tahun) + " " + jam; 

 

  if (isnan(kelembaban) || isnan(suhu)) { 

    Serial.println(F("Gagal membaca DHT sensor!")); 

    return; 

  } 

 

  while (gpsSerial.available() > 0) { 

    if (gps.encode(gpsSerial.read())) { 

      if (gps.location.isValid()) { 

        latitude = gps.location.lat(); 
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        lat_str = String(latitude , 10); 

        longitude = gps.location.lng(); 

        lng_str = String(longitude , 10); 

      } 

        Firebase.setString("kelompok11/latitude", lat_str); 

        Firebase.setString("kelompok11/longitude", lng_str); 

    } 

  } 

 

  Serial.print(F("Latitude : ")); 

  Serial.print(latitude); 

  Serial.print(F(" Longitude: ")); 

  Serial.print(longitude); 

  Serial.print("\n"); 

  Serial.print(F("Kelembapan : ")); 

  Serial.print(kelembaban); 

  Serial.print(F(" Suhu: ")); 

  Serial.print(suhu); 

  Serial.print(F(" °C")); 

  Serial.print("\n"); 

  Serial.print("Terakhir Diperbarui: "); 

  Serial.println(waktu_terkini); 

  Serial.println(""); 

 

  if (Firebase.failed()) { 

    Serial.print("Gagal mendapatkan firebase"); 
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    Serial.println(Firebase.error()); 

    return; 

  } 

 

  Firebase.setFloat("kelompok11/suhu", suhu); 

  Firebase.setFloat("kelompok11/kelembaban", 

kelembaban); 

  Firebase.setString("kelompok11/diperbaharui", 

waktu_terkini); 

 

  delay(2000); 

} 

Sourcode Monitoring Suhu dan Kelembaban: 

https://drive.google.com/file/d/19pBPRYG-

QPQQGNdHH49zJqW-uc2FrHD4/view?usp=sharing  

 

Note: 

#define FIREBASE_HOST "diisi nama database firebase 

Kalian!!" // nama database (tanpa https dan “/” diakhir)  

#define FIREBASE_AUTH "Masukan Kode rahasia 

Database Kalian!!" 

8) Selanjutnya kita verifikasi kode programnya. Klik Verify: untuk 

mencari kesalahan kodingan. 
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9) Untuk melihat kesalahan Kodingan dibagian Jendela debug. 

10) Selanjutnya kita mengupload kodingan ke NodeMCU esp8266. 

Klik Upload. 

 

11) Tunggu Prosesnya sampai selesai. 

12) Untuk Melihat outputnya berupa teks silakan klik serial 

monitor. 
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13) Output pada serial monitor 

 

Note: Apabila data GPS nya belum ada seperti Latitude dan 

longitude, Silakan tunggu, atau bisa dengan mencoba diruang 

terbuka. 

14) Silakan cek juga database pada firebase apakah datanya sudah 

berhasil terupload. 

 

6.13. Download dan Instalasi u-blox u-center 

1) Silakan akses web u-blox https://www.u-blox.com/en/product/u-

center 

2) Klik dan download u-center for Windows, v.21.09 
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3) Ekstrak file hasil download 

 

4) Klik kanan file hasil yang sudah diekstrak dan pilih run as 

administrator. 
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5) Pilih Bahasa yaitu English, lalu klik OK. 

 

 

6) Klik Next. 
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7) Klik “I Agree” 

 

8) Samakan setting seperti gambar dibawah, lalu klik Next. 
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9) Pilih lokasi penginstallan, lalu klik Istall. 

 

10) Tunggu proses penginstalan. 
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11) Setelah proses install selesai, klik Finish. 

 

12) Setelah itu, maka akan tampil halaman antarmuka u-center. 
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BAB 7 

REMOTE SENSING 

 

7.1. Tujuan 

a. Memahami konsep remote sensing. 

b. Mengetahui alat-alat yang dapat digunakan untuk melakukan 

remote sensing. 

c. Memahami pengaplikasian remote sensing. 

d. Mengetahui sumber-sumber data remote sensing terbuka. 

e. Memahami proses penggunaan GPS untuk akuisisi data 

lokasi di permukaan bumi. 

 

7.2. Pengertian Remote Sensing 

Remote sensing atau pengindraan jarak jauh (disingkat indraja) 

adalah pengukuran atau akuisisi data suatu objek atau fenomena oleh 

sebuah alat yang tidak secara fisik melakukan kontak dengan objek 

tersebut atau dari jarak jauh, misalnya dari pesawat, pesawat luar 

angkasa, satelit, dan kapal. Beberapa contoh alat-alat yang dapat 

digunakan untuk melakukan remote sensing adalah: 

1. Satelit, yaitu benda yang mengorbit benda lain dengan 

periode revolusi dan rotasi tertentu. Ada dua jenis satelit 

yakni satelit alami dan satelit buatan. Satelit merupakan salah 

satu instrumen untuk mengakuisisi data dari permukaan 

bumi mulai dari citra, suhu, dan kondisi atmosfer bumi. 

2. Unmanned Aerial Vehicle (UAV) atau yang lebih sering 

disebut drone merupakan pesawat tanpa awak yang dapat 
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dikendalikan melalui remote control. Dengan menggunakan 

drone, tampak permukaan bumi dapat direkam menggunakan 

resolusi tinggi. Selain itu, berbagai sensor dapat dipasang 

pada drone untuk mengumpulkan data yang kaya. 

3. Internet of Things (IoT) merupakan istilah untuk alat-alat 

pintar yang terhubung dan berkomunikasi dengan internet. 

Beberapa contoh alat IoT misalnya smartphone, thermostat, 

dan CCTV. Berbagai alat-alat tersebut dapat menjadi sumber 

data yang bisa diintegrasikan dengan data spasial untuk 

memperkaya data atribut pada SIG. 

Remote sensing memiliki banyak aplikasi yang telah diterapkan di 

berbagai sektor, misalnya: 

1. Geodesi, pengolahan dan analisis data citra satelit, foto 

udara, foto small format, komponen pasut laut, serta 

pengolahan data integrasi SIG dan otogrammetri 

2. Kelautan, pengamatan sifat fisis air laut, pasang surut air laut 

maupun gelombang laut, pemetaan perubahan pantai, abrasi, 

sedimentasi, serta pemetaan perubahan kawasan hutan 

bakau. 

3. Hidrologi, pemanfaatan daerah aliran sungai (DAS) dan 

konservasi sungai, pemetaan sungai dan studi sedimentasi 

sungai, pemanfaatan luas daerah dan intensitas banjir, serta 

pengamatan kecenderungan pola aliran sungai. 

4. Geologi, penentuan struktur geologi dan macamnya; 

pemantauan daerah bencana akibat gempa, kebakaran, atau 

tsunami; pemantauan debu vulkanik, distribusi sumber daya 



197 
 

alam, pencemaran laut dan lapisan minyak di laut; serta 

pemanfaatan di bidang pertahanan dan militer, dan 

pemantauan permukaan di samping pemotretan dengan 

pesawat terbang dan aplikasi sistem informasi geografi (SIG) 

5. Meteorologi dan klimatologi, membantu analisis cuaca 

dengan menentukan daerah tekanan rendah dan daerah 

bertekanan tinggi, daerah hujan, dan badai siklon; 

mengetahui sistem atau pola angin permukaan, pemodelan 

meteorologi dan data klimatologi; serta pengamatan iklim 

suatu daerah melalui pengamatan tingkat kewarnaan dan 

kandungan air di udara. 

6. Oseanografi, pengamatan sifat fisis air (seperti suhu, warna, 

kadar garam, dan arus laut), pengamatan pasang surut dengan 

gelombang laut (tinggi, frekuensi, arah), pencarian distribusi 

suhu permukaan, serta membantu studi perubahan pasir 

pantai akibat erosi dan sedimentasi. 

Beberapa sumber data terbuka untuk mengakses data remote sensing 

untuk SIG adalah: 

1. USGS EarthExplorer (https://earthexplorer.usgs.gov/) 

2. ESA Copernicus (https://scihub.copernicus.eu/) 

3. MAXAR DigitalGlobe Worldview 

(https://discover.digitalglobe.com/) 

Untuk melakukan proses remote sensing, diperlukan referensi 

spasial untuk menentukan sumber atau lokasi data yang diamati di 

permukaan bumi. Salah satu caranya adalah dengan menggunakan 

GPS. GPS (Global Positioning System)  merupakan sistem navigasi 
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menggunakan satelit dan dapat digunakan untuk menentukan lokasi 

suatu titik pada permukaan bumi. GPS bekerja dengan cara 

melakukan metode trilateration, yaitu mencari titik dari perpotongan 

beberapa satelit berdasarkan jaraknya. 

 

7.3. Studi Kasus Remote Sensing  

Pada studi kasus ini Anda akan menggunakan alat IoT yang 

telah disediakan. Pastikan perangkat NodeMCU Anda sudah 

terpasang dengan benar sesuai dengan skema yang tersedia. 

1) Buka Arduino IDE, kemudian salin kode berikut: 

https://github.com/MAROON-LABKOM/script 

/blob/master/gis/gps_passthrough.ino. 

2) Hubungkan modul IoT dengan komputer menggunakan kabel 

microUSB. 

3) Pilih port yang tepat pada Arduino IDE dengan cara klik Tools 

→ Port. 

4) Pilih board yang tepat dengan cara klik Tools → Board dan pilih 

NodeMCU 0.9 atau 1.0. 
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5) Klik Upload untuk memprogram Arduino. 

6) Unduh dan install aplikasi u-center. https://www.u-

blox.com/en/product/u-center  

 

7) Buka aplikasi u-center, kemudian klik drop down yang ada pada 

tombol Connect. Pilih 9600 kemudian klik tombol Connect. 
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8) Bawa laptop dan modul IoT Anda ke tempat yang terbuka dan 

tidak terhalang dari sinar matahari langsung untuk memastikan 

modul GPS dapat melacak lokasi Anda dengan tepat. 

 

9) Setelah beberapa waktu Anda akan mendapatkan titik koordinat 

yang dapat dilihat pada pojok kanan atas (latitude dan longitude) 

dan data mengenai satelit yang digunakan untuk melacak lokasi 

Anda. 
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BAB 8 

IMPLEMENTASI DAN STUDI KASUS WEB GIS 

 

8.1. Tujuan 

a. Memahami konsep web GIS. 

b. Mengetahui arsitektur web GIS. 

c. Memahami keuntungan penerapan web GIS. 

d. Membangun web GIS. 

 

8.2. Pengertian Web GIS 

Web GIS merupakan pengembangan dari aplikasi SIG berbasis 

web yang terintegrasi satu sama lain. WebGIS memiliki berbagai 

fitur yang bisa mendukung dalam menampilkan dan menganalisis 

data untuk bisa diakses secara bebas melalui laman internet. Dalam 

pengoperasiannya, Web GIS terdiri atas server dan client.  Server 

berperan sebagai pusat penyedia yang saling terintegrasi melalui 

data, peta dan web. Client bertindak sebagai pengguna dalam 

mencari informasi yang diperlukan. 
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Gambar 37. Web GIS 

(Sumber: inolabs) 

 

Keuntungan web GIS: 

• Pengguna (user) tidak memerlukan software khusus untuk 

bisa mengakses informasi WebGIS, yaitu cukup dengan 

menggunakan internet browser yang bisa diakses melalui 

desktop ataupun media lain 

• Tersedianya peta-peta informasi secara digital yang disusun 

atas struktur dan managemen data yang baik sehingga bisa 

dimengerti dan dipahami secara mudah. 

• Mendukung dalam perencanaan makro, pengambilan 

kebijakan, dan tata kelola dari pemerintahan. 

• Membantu dalam mencari lokasi tertentu dengan mengetikan 

keyword dengan mudah dan cepat. 

Mencari informasi berupa geografi, demografi, dan psikografi. 
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8.3. Implementasi dan Studi Kasus Web GIS 

Pada kasus ini Anda akan membuat sebuah web GIS yang dapat 

menampilkan titik-titik lokasi sensor IoT yang akan menampilkan 

data pengukuran suhu udara dan kelembapan udara secara real time. 

Lokasi alat akan didapatkan dari modul GPS u-box NEO V3 dan 

pengukuran suhu dan kelembapan udara akan diukur menggunakan 

DHT11. 

 

8.4. Mendaftar pada Firebase 

Pastikan Anda sudah mengikuti panduan pada bab sebelumnya 

untuk mendaftar akun Firebase. Pada tahap ini Anda akan mencari 

URL database dan secret key untuk mengakses realtime database 

pada Firebase. 

1) Buka Firebase, kemudian klik ikon gear dan klik Project 

settings. 

 

2) Pada tab General, kemudian scroll ke bawah dan cari 

databaseURL. Salin alamat URL tersebut dan simpan ke 
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notepad. 

 

3) Pada tab Service accounts, klik Database secrets kemudian klik 

Show. Salin kode tersebut dan simpan ke notepad. 

 

4) Setelah Anda memiliki kedua data di atas, Anda dapat 

melanjutkan ke tahap selanjutnya. 

 

8.5. Memprogram NodeMCU 

1) Buka Arduino IDE, kemudian salin kode berikut: 

https://github.com/MAROON-
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LABKOM/script/blob/master/gis/firebase_iot.ino. 

2) Ubah bagian #define sesuai dengan detail koneksi Wi-Fi dan  

 

3) Hubungkan modul IoT dengan komputer menggunakan kabel 

micro USB. 

4) Pilih port yang tepat pada Arduino IDE dengan cara klik Tools 

→ Port. 

5) Pilih board yang tepat dengan cara klik Tools → Board dan pilih 

NodeMCU 0.9 atau 1.0. 

 

6) Klik Upload untuk memprogram Arduino. Apabila Anda 

mengalami kegagalan saat melakukan upload, ubah pengaturan 

Tools → MMU berikut pada Arduino IDE dan upload kembali. 
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Jika semua proses yang dilakukan sudah sesuai, maka data akan 

segera masuk ke Firebase pada menu Realtime Database seperti 

gambar berikut. 

 

 

8.6. Menampilkan Data Sensor pada Web 

Setelah data berhasil masuk pada realtime database, tahap 

selanjutnya adalah menampilkan data sensor pada web. 

1) Buka Visual Studio Code atau editor lain pada komputer Anda, 

kemudian unduh dan buka file berikut: 

https://github.com/MAROON-
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LABKOM/script/blob/master/gis/index.html. 

2) Buka kembali Project settings pada Firebase, kemudian ganti 

potongan kode pada file indeks.html di atas sesuai dengan data 

dari Firebase. 

 

3) Simpan dan buka file tersebut, jika konfigurasi sudah sesuai 

maka web GIS akan muncul menampilkan titik-titik data. 
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GLOSARIUM 

 

ArcGIS software berbasis Geographic Information System. 

Arduino IDE software yang di gunakan untuk memprogram di 

Arduino. 

Data keterangan yang benar dan nyata. 

Firebase layanan dari Google yang digunakan untuk mempermudah 

para pengembang aplikasi. 

Geoserver server sumber terbuka. 

Hardware perangkat keras. 

Internet of Things objek yang memiliki kemampuan untuk 

mentransfer data melalui jaringan tanpa memerlukan interaksi 

manusia. 

Intersect operasi overlay yang menggabungkan fitur yang 

berpotongan (titik, garis, atau poligon). 

Leaflet bentuk media komunikas. 

MySQL sistem manajemen database. 

NodeMCU platform IoT yang bersifat opensource. 

Overlay proses penyatuan data dari lapisan layer yang berbeda. 

Peta Analog peta dalam bentuk cetakan. 

PostGIS menyimpan dan mengelola informasi spasial. 

Sensor alat untuk mendeteksi. 

Sistem Informasi Geografis sistem berbasis komputer yang 

digunakan untuk memanipulasi, menganalisis, menyimpan 

informasi geografis. 

Software perangkat lunak. 
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Spasial berkenaan dengan ruang atau tempat. 

U-Blox sensor global positioning system. 

Visual Code Studio perangkat lunak penyunting kode. 

XAMPP software web server local.  
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